
vFoglight™ 5.2.4 

User Guide



© 2008 Quest Software, Inc. ALL RIGHTS RESERVED.
This guide contains proprietary information protected by copyright.   The software described in this guide is furnished 
under a software license or nondisclosure agreement.   This software may be used or copied only in accordance with 
the terms of the applicable agreement.  No part of this guide may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, including photocopying and recording for any purpose other than the purchaser's 
personal use without the written permission of Quest Software, Inc.

If you have any questions regarding your potential use of this material, contact:
Quest Software World Headquarters
LEGAL Dept
5 Polaris Way
Aliso Viejo, CA 92656
www.quest.com
email: legal@quest.com

Refer to our Web site for regional and international office information.

Trademarks
Quest, Quest Software, the Quest Software logo, Aelita, Akonix, Akonix L7 Enterprise, Akonix L7 Enforcer, 
AppAssure, Benchmark Factory, Big Brother, DataFactory, DeployDirector, ERDisk, vFoglight, Funnel Web, I/
Watch, Imceda, InLook, IntelliProfile, InTrust, Invertus, IT Dad, I/Watch, JClass, Jint, JProbe, LeccoTech, LiteSpeed, 
LiveReorg, MessageStats, NBSpool, NetBase, Npulse, NetPro, PassGo, PerformaSure, Quest Central, SharePlex, 
Sitraka, SmartAlarm, Spotlight, SQL LiteSpeed, SQL Navigator, SQL Watch, SQLab, Stat, StealthCollect, Tag and 
Follow, Toad, T.O.A.D., Toad World, vANALYZER, vAUTOMATOR, vCONTROL, vCONVERTER, vEssentials, 
vFOGLIGHT, vOPTIMIZER, vRanger Pro, vReplicator, Vintela, Virtual DBA, VizionCore, Xaffire, and XRT are 
trademarks and registered trademarks of Quest Software, Inc in the United States of America and other countries.  
Other trademarks and registered trademarks used in this guide are property of their respective owners.

Disclaimer
The information in this document is provided in connection with Quest products. No license, express or implied, by 
estoppel or otherwise, to any intellectual property right is granted by this document or in connection with the sale of 
Quest products. EXCEPT AS SET FORTH IN QUEST'S TERMS AND CONDITIONS AS SPECIFIED IN THE 
LICENSE AGREEMENT FOR THIS PRODUCT, QUEST ASSUMES NO LIABILITY WHATSOEVER AND 
DISCLAIMS ANY EXPRESS, IMPLIED OR STATUTORY WARRANTY RELATING TO ITS PRODUCTS 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, OR NON-INFRINGEMENT. IN NO EVENT SHALL QUEST BE LIABLE FOR ANY 
DIRECT, INDIRECT, CONSEQUENTIAL, PUNITIVE, SPECIAL OR INCIDENTAL DAMAGES (INCLUDING, 
WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION OR LOSS OF 
INFORMATION) ARISING OUT OF THE USE OR INABILITY TO USE THIS DOCUMENT, EVEN IF QUEST HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Quest makes no representations or warranties with 
respect to the accuracy or completeness of the contents of this document and reserves the right to make changes 
to specifications and product descriptions at any time without notice. Quest does not make any commitment to 
update the information contained in this document.

License Credits and Third Party Information
To view license credit information, click the License Credits link on the Welcome to vFoglight online help page

User Guide
March 2009
Version 5.2.4

http://www.quest.com
mailto:legal@quest.com


Table of Contents
Introduction to this Guide ...................................................................................................................................9
About vFoglight .............................................................................................................................................................. 10
About this Guide............................................................................................................................................................. 10
vFoglight Documentation Suite ...................................................................................................................................... 11

Core Documentation Set ....................................................................................................................................... 12
Cartridge Documentation Sets .............................................................................................................................. 12
Feedback on the Documentation........................................................................................................................... 13

Text Conventions ........................................................................................................................................................... 13
About Vizioncore Inc. ..................................................................................................................................................... 14
Contacting Dell ............................................................................................................................................................... 16

Getting Started with vFoglight..........................................................................................................................29
Logging in to vFoglight ................................................................................................................................................... 30
Introducing the Browser Interface .................................................................................................................................. 30

Welcome Page ...................................................................................................................................................... 30
Screen Elements ................................................................................................................................................... 31

Customizing vFoglight .................................................................................................................................................... 36
User Preferences................................................................................................................................................... 36
Home Page............................................................................................................................................................ 39
Themes.................................................................................................................................................................. 39

Navigation in vFoglight .....................................................................................................................................41
Introduction to Navigation............................................................................................................................................... 42

Breadcrumb Trail ................................................................................................................................................... 42
Caching ................................................................................................................................................................. 42
Table Links ............................................................................................................................................................ 43
Icon Links .............................................................................................................................................................. 43



4 vFoglight  
User Guide 
Bookmarks ............................................................................................................................................................. 43
Understanding Roles in vFoglight................................................................................................................................... 46

Working with Dashboards ................................................................................................................................ 49
Introduction to Dashboards............................................................................................................................................. 50

Display Functions................................................................................................................................................... 50
Common Views............................................................................................................................................................... 58

Alarm List ............................................................................................................................................................... 58
Filtering the Alarms View ....................................................................................................................................... 62
Acknowledging an Alarm ....................................................................................................................................... 63
Clearing an Alarm .................................................................................................................................................. 65
Instance ................................................................................................................................................................. 66
Alarm Details.......................................................................................................................................................... 67
Host Summary ....................................................................................................................................................... 74

Creating a Custom Dashboard ....................................................................................................................................... 76
Deleting a Custom Dashboard............................................................................................................................... 78

Working with Charts........................................................................................................................................................ 78
Creating a Metrics Chart ........................................................................................................................................ 78
Zooming Into Charts .............................................................................................................................................. 80
Chart Options......................................................................................................................................................... 82
Metrics Chart Editor ............................................................................................................................................... 83
Grouping Metrics with Many Parent Hosts............................................................................................................. 87
Setting Metric Chart Labels ................................................................................................................................... 88

Viewing Dashboard Properties ....................................................................................................................................... 89
Working With Tables....................................................................................................................................................... 91
Printing Views ................................................................................................................................................................. 92

Working with Services and Alarms ................................................................................................................. 93
Overview......................................................................................................................................................................... 94

Icons ...................................................................................................................................................................... 94
Monitoring Services ........................................................................................................................................................ 96
Viewing System-Wide Alarms and Service Details....................................................................................................... 104
Examining Details on a Single Service ......................................................................................................................... 105
Viewing Service Levels................................................................................................................................................. 106

Service Level Agreement Information.................................................................................................................. 107



Table of Contents 5
 

Availability Graphs................................................................................................................................................107
Choosing Another Service Level ..........................................................................................................................108

Building a Service .........................................................................................................................................................108
Creating a New Category .....................................................................................................................................109
Creating a New Application ..................................................................................................................................109
Building a Service.................................................................................................................................................110
Adding Dynamic Managed Components..............................................................................................................111
Adding an Application Tier ...................................................................................................................................113
Removing a Service, Category, Monitored Component, or Tier...........................................................................114
Editing a Service Name........................................................................................................................................114
Editing a Service Description ...............................................................................................................................115

Filtering Alarms .............................................................................................................................................................115
Monitoring System-Wide Alarms...................................................................................................................................118

Monitoring Agents and Hosts.........................................................................................................................121
Overview .......................................................................................................................................................................122
Viewing Agents .............................................................................................................................................................122
Viewing Host Performance............................................................................................................................................124

Viewing Performance of a Single Host ................................................................................................................124
Viewing Performance on All Monitored Hosts ......................................................................................................125
Viewing Real-Time Performance..........................................................................................................................126

Viewing Host Details .....................................................................................................................................................128
Viewing Details on a Single Host .........................................................................................................................128
Viewing Host Details in Portlet Format.................................................................................................................129

Monitoring the vFoglight Management Server..............................................................................................131
Overview .......................................................................................................................................................................132
Viewing Logs.................................................................................................................................................................132
Viewing Performance-related Dashboards ...................................................................................................................134
Inspecting Object Types................................................................................................................................................141

Viewing a Data Object..........................................................................................................................................142
Cleaning up Data Objects .............................................................................................................................................143

Deleting a Data Object .........................................................................................................................................143
Selecting Metrics to Compare .......................................................................................................................................144

Adding Other Metrics to the Chart........................................................................................................................145



6 vFoglight  
User Guide 
Viewing Server Metrics ................................................................................................................................................. 147
Looking at Server Details.............................................................................................................................................. 149
Viewing MySQL Database Details ............................................................................................................................... 150
Viewing Persistence Handler Details ............................................................................................................................ 151

Working with Applications ............................................................................................................................. 153
Monitoring an Application ............................................................................................................................................. 154
Building an Application ................................................................................................................................................. 155

Step 1: Adding Tiers to an Application................................................................................................................. 156
Step 2: Creating Tiers, Defining Tier Flows and Tier Components...................................................................... 157
Step 3: Adding Tiers to Preview the New Application and Tier Flows ................................................................. 159
Removing an Application, Tier, Tier Flow, or Tier Component ............................................................................ 160

Working with Reports ..................................................................................................................................... 161
Introducing the Reports Module.................................................................................................................................... 162

Report Manager Dashboard ................................................................................................................................ 162
Reports Dashboard.............................................................................................................................................. 164

Supplied Report Templates .......................................................................................................................................... 164
Event Analysis for Any Resources Report ........................................................................................................... 165
Event Analysis for Hosts Report .......................................................................................................................... 168
Physical Host - CPU Utilization Monthly Summary Report .................................................................................. 171
Physical Host - Memory Utilization Monthly Summary Report............................................................................. 172
Physical Host - Network Utilization Monthly Summary Report............................................................................. 174
Physical Host Utilization Summary - Last 10 Days Report .................................................................................. 175
Management Server Performance Summary Report........................................................................................... 177
Physical Host Load Summary Report .................................................................................................................. 180
Physical Host Performance Details Report .......................................................................................................... 183
Physical Host Performance Summary Report ..................................................................................................... 187
Service Level Summary Report ........................................................................................................................... 190

Working with Reports.................................................................................................................................................... 192
Running a Report................................................................................................................................................. 192
Scheduling a Report ............................................................................................................................................ 194
Testing a Report Template .................................................................................................................................. 197
Adding a New Schedule....................................................................................................................................... 198

Managing Scheduled Reports ...................................................................................................................................... 200



Table of Contents 7
 

Editing a Scheduled Report..................................................................................................................................200
Copying a Scheduled Report ...............................................................................................................................201
Disabling/Enabling a Scheduled Report...............................................................................................................202
Deleting a Scheduled Report ...............................................................................................................................203
Applying a Filter to Scheduled Reports ................................................................................................................203

Managing Generated Reports.......................................................................................................................................204
Viewing a Generated Report ................................................................................................................................204
Applying a Filter to Generated Reports ................................................................................................................206
Deleting a Generated Report ...............................................................................................................................207
Scheduling a Generated Report...........................................................................................................................208
Adding Your Own Logo to Reports.......................................................................................................................208

Working with Custom Reports.......................................................................................................................................213
Creating a Custom Report Template....................................................................................................................213
Creating a CSV Report.........................................................................................................................................215
Customizing the Header or Footer of a Custom Report .......................................................................................215
Printing a Custom Report .....................................................................................................................................216
Deleting a Custom Report ....................................................................................................................................216
Example: Create a Custom Host Report ..............................................................................................................217
Example: Create an SLA Availability Report ........................................................................................................220

Working with Data and Data Sources ............................................................................................................225
Overview .......................................................................................................................................................................226
Data Dashboard ............................................................................................................................................................226

Understanding Metrics and Observations ............................................................................................................227
Data Sources Dashboard..............................................................................................................................................229

Index..................................................................................................................................................................231



8 vFoglight  
User Guide 



Introduction to this Guide

This chapter provides information about what is contained in the vFoglight User Guide. 
It also provides information about the vFoglight documentation suite and Vizioncore.

This chapter contains the following sections:

About vFoglight............................................................................................................................10
About this Guide ..........................................................................................................................10
vFoglight Documentation Suite.................................................................................................... 11
Text Conventions .........................................................................................................................13
About Vizioncore Inc....................................................................................................................14
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About vFoglight
vFoglight helps IT organizations understand the virtual infrastructure by managing the 
relationships and interaction between all the components in the environment, including 
data centers, data stores, clusters, resource pools, hosts and virtual machines. With 
vFoglight, administrators can quickly determine the root-cause of an incident or 
problem, track virtual machine (VM) movements and understand their impact, and 
identify contention for resources between virtual machines.

About this Guide
This User Guide provides configuration instructions, conceptual information and 
instructions on how to use the browser interface. 

 This guide is intended for any user who wants to configure vFoglight using the browser 
interface.

The User Guide is organized as follows:

Chapter 1, Getting Started with vFoglight—This section focuses on identifying the 
key screen elements in vFoglight as well as customizing vFoglight according to User 
Preferences, setting home pages and themes. 

Chapter 2, Navigation in vFoglight—This section introduces the navigation tools used 
in vFoglight and understanding the concept of roles in vFoglight.

Chapter 3, Working with Dashboards—This section identifies the tools and 
techniques to work with dashboards as well as work with tables and charts.

Chapter 4, Working with Services and Alarms—This walkthrough instructs you on 
how to monitor services, examine service levels, and create a service. Details on 
viewing system-wide alarms for all monitored services is also provided.

Chapter 5, Monitoring Agents and Hosts—This section overviews the dashboards to 
monitor agents and hosts such as view active host details, browse and monitor hosts, 
and obtain host resource information.

Chapter 6, Monitoring the vFoglight Management Server—This section overviews 
monitoring vFoglight performance, such as cleaning up data objects, viewing server 
metrics and server details, viewing SQL database details, and viewing persistence 
handler details.
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vFoglight Documentation Suite 
Chapter 7, Working with Applications—This chapter describes how to monitor and 
create an application.

Chapter 8, Working with Reports—This chapter introduces the Reports dashboard 
and Report Manager dashboard. Reports can be created based on the supplied report 
templates or your own custom report. It also describes working with scheduled and 
generated reports, and the functions that are available to work with reports such as run a 
report, schedule a report, test a report template, and add a new schedule to the default 
report schedules list. 

Chapter 9, Working with Data and Data Sources—This chapter introduces the Data 
dashboard and Data Sources dashboard that are primarily used by dashboard designers 
to examine data objects as well as choose a data source in vFoglight.

vFoglight Documentation Suite
The vFoglight documentation suite is made up of the core documentation set, plus the 
documentation set for each vFoglight cartridge that you deploy. Documentation is 
provided in a combination of online help, PDF and HTML.

• Online Help: You can open the online help by selecting the Help tab from 
vFoglight’s action panel.

• PDF: The Getting Started Guide, What’s New Guide, System Requirements and 
Platform Support Guide, Installation and Setup Guide set, Administration and 
Configuration Guide, vFoglight User Guide, Command-Line Reference Guide, 
Web Component Guide, and Web Component Tutorial, are provided as PDF files. 
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The PDF guides are included in the zip file downloaded from Vizioncore. 
Adobe® Reader® is required.

• HTML: Release Notes are provided in HTML.

Core Documentation Set
The core documentation set consists of the following files:

• Release Notes (HTML)

• Getting Started Guide (PDF)

• What’s New Guide (PDF)

• System Requirements and Platform Support Guide (PDF)

• Installation and Setup Guide set (all in PDF format):

• Installation and Setup Guide—Installing on Windows with an Embedded 
MySQL Database

• Installation and Setup Guide—Installing on Windows with an External 
MySQL Database

• Installation and Setup Guide—Installing on Windows with an External Oracle 
Database

• Administration and Configuration Guide (PDF and online help)

• vFoglight User Guide (PDF and online help)

• Advanced Configuration Guide set

• Command-Line Reference Guide (PDF and online help)
• Web Component Guide (PDF and online help)
• Web Component Tutorial (PDF and online help)
• Web Component Reference (online help)

Cartridge Documentation Sets
When you deploy a cartridge, the documentation set for the cartridge is installed. The 
online help for the cartridge is integrated automatically with the core vFoglight help. 
When you open the help, the name of the cartridge is displayed in a top level entry 
within the table of contents.
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Text Conventions 
Some cartridges include additional PDF guides, which may be one or more of the 
following: a Getting Started Guide, an Installation Guide, a User Guide, and a 
Reference Guide.

Feedback on the Documentation
We are interested in receiving feedback from you about our documentation. For 
example, did you notice any errors in the documentation? Were any features 
undocumented? Do you have any suggestions on how we can improve the 
documentation? All comments are welcome. Please submit your feedback to the 
following email address:

info@vizioncore.com

Please do not submit Technical Support related issues to this email address.

Text Conventions
The following table summarizes how text styles are used in this guide:

Convention Description

Code Monospace text represents code, code objects, and command-
line input. This includes:
• Java language source code and examples of file contents
• Classes, objects, methods, properties, constants, and events
• HTML documents, tags, and attributes

Variables Monospace-plus-italic text represents variable code or 
command-line objects that are replaced by an actual value or 
parameter.

Interface Bold text is used for interface options that you select (such as 
menu items) as well as keyboard commands.

Files, components, 
and documents 

Italic text is used to highlight the following items:
• Pathnames, file names, and programs
• The names of other documents referenced in this guide

mailto:info@vizioncore.com
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About Vizioncore Inc.
Vizioncore was formed in July 2002 as a consulting and software-development 
company with the mission to create easy-to-use software solutions that performed 
reliable and repeatable automation of datacenter functions specifically for the Citrix 
platform.  A main corporate goal was to enable business partners to offer solutions that 
targeted real-world IT issues and provided the best possible installation and automation 
for their clients' systems.

Vizioncore's solutions have proved successful in organizations from small to mid-sized 
businesses to large enterprises, in a wide variety of vertical industries, including 
Financial Services, Government, Healthcare, Manufacturing, and High Tech. 
Vizioncore, Inc. can be found in offices around the globe and at www.vizioncore.com.

http://www.vizioncore.com
http://www.vizioncore.com
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Contacting Dell 
Note: If you do not have an active Internet connection, you can find contact information on your purchase invoice, 
packing slip, bill, or Dell product catalog. 

Dell provides several online and telephone-based support and service options. Availability varies by country and 
product, and some services may not be available in your area. To contact Dell for sales, technical support, or customer 
service issues: 

1 Visit http://support.dell.com. 

2 Verify your country or region in the Choose A Country/Region drop-down menu at the bottom of the page. 

3 Click Contact Us on the left side of the page.Note: Toll-free numbers are for use within the country for which 
they are listed. 

4 Select the appropriate service or support link based on your need. 

5 Choose the method of contacting Dell that is convenient for you.

Country (City)
International Access 
Code
Country Code
City Code

Service Type Area Codes,
Local Numbers, and

Toll-Free Numbers
Web and E-Mail Addresses

Anguilla Web Address
E-Mail Address
Technical Support., Customer Service, Sales

www.Dell.com/ai
la‐techsupport@dell.com

toll-free: 800-335-0031
Antigua and Barbuda Web Address

E-Mail Address
Technical Support., Customer Service, Sales

www.Dell.com.ag
la‐techsupport@dell.com

1-800-805-5924
Aomen Technical Support

Dell™ Dimension™, Dell Inspirion™, Dell 
Optiplex™, Dell Lattitude™, and Dell 
Precision™Servers and Storage

0800-105

0800-105

Argentina (Buenos Aires)
International Access 
Code: 00
Country Code: 54
City Code: 11

Web Address
E-Mail Address for Desktop/ Portable Computers
E-Mail Address for Servers and EMC® Storage 
Products
Customer Service
Technical Support
Technical Support Services
Sales

www.dell.com.ar
la‐techsupport@dell.com
la_enterprise@dell.com
toll-free: 0-800-444-0730

toll-free: 0-800-444-0733
toll-free: 0-800-444-0724

        0-800-444-3355
Aruba Web Address

E-Mail Address
Technical Support., Customer Service, Sales

www.Dell.com/aw
la‐techsupport@dell.com

toll-free: 800-1578
Australia (Sydney)
International Access 
Code: 0011
Country Code: 61
City Code: 2

Web Address
Contact Dell Web Address
Technical Support., Customer Service, Sales

support.ap.dell.com
support.ap.dell.com/contactus

13DELL-133355

http://www.Dell.com/ai
mailto:la-techsupport@dell.com
http://www.Dell.com.ag
mailto:la-techsupport@dell.com
http://www.dell.com.ar
mailto:la-techsupport@dell.com
mailto:la_enterprise@dell.com
http://www.Dell.com/aw
mailto:la-techsupport@dell.com


Austria (Vienna)
International Access 
Code: 900
Country Code: 43
City Code: 1

Web Address
E-Mail Address
Home/Small Business Sales
Home/Small Business Fax
Home/Small Business Customer Service
Home/Small Business Support
Preferred Accounts/Corporate Customer
Service Preferred Accounts/Corporate Customer
Switchboard

Support.euro.dell.com
Tech_support_central_europe@dell.com

0820 240 530 00
0820 240 530 49
0820 240 530 14
0820 240 530 17
0820 240 530 16
0820 240 530 17
0820 240 530 00

Bahamas Web Address
E-Mail Address
Technical Support., Customer Service, Sales

www.dell.com/bs
la‐techsupport@dell.com

toll-free: 1-866-874-3038
Barbados Web Address

E-Mail Address
Technical Support., Customer Service, Sales

www.dell.com/bb
la‐techsupport@dell.com

1-800-534-3142
Belgium (Brussels) Web Address

General Support
General Support Fax
Customer Service
Corporate Sales
Fax
Switchboard

Support.euro.dell.com
02 481 92 88
02 481 92 95

02 713 15 65 
02 481 91 00
02 481 91 99
02 481 91 00

Bolivia Web Address
E-Mail Address
Technical Support., Customer Service, Sales

www.dell.com/bo
la_techsupport@dell.com

toll-free: 800-10-0238
Brazil
International Access 
Code: 00
Country Code: 55
City Code: 51

Web Address
E-Mail Address
Customer Service and Tech Support
Technical Support Fax
Customer Service Fax
Sales

www.dell.com/br
BR_TechSupport@dell.com

0800 970 3355
51 2104 5470
51 2104 5480

0800 722 3498
British Virgin Islands Technical Support, Customer Service, Sales toll-free: 1-866-278-6820
Brunei
Country Code: 673

Technical Support (Penang, Malaysia)
Customer Service (Penang, Malaysia)
Transaction Sales (Penang, Malaysia)

604 633 4966
604 633 4888
604 633 4955

Canada (North York, 
Ontario)
International Access 
Code: 011

Online Order Status Web Address
AutoTech (automated Hardware and Warranty 
Support)
Customer Service
Home/Home Office
Small Business
Medium/Large Business, Government, Education
Hardware Warranty Phone Support
Computers for Home/Home Office
Computers for Small/Medium/Large Business
Government
Printers, Projectors, Televisions, Handheld, 
Digital
Jukebox, and Wireless Sales
Home and Home Office Sales
Small Business
Medium/Large Business, Government
Spare Parts and Extended Service

www.dell.ca/ostatus

support.ca.dell.com
toll-free:1-800-247-9362
toll-free:1-800-847-4096
toll-free:1-800-906-3355
toll-free:1-800-387-5757

toll-free:1-800-847-4096
toll-free:1-800-387-5757

1-877-335-5767

toll-free:1-800-999-3355
toll-free:1-800-387-5752
toll-free:1-800-387-5755

1 866 440 3355

Cayman Islands E-Mail Address
Technical Support, Customer Service, Sales

la‐techsupport@dell.com
1-877-262-5415

mailto:Tech_support_central_europe@dell.com
http://www.dell.com/bs
mailto:la-techsupport@dell.com
http://www.dell.com/bb
mailto:la-techsupport@dell.com
http://www.dell.com/bo
mailto:la_techsupport@dell.com
http://www.dell.com/br
mailto:BR_TechSupport@dell.com
http://www.dell.ca/ostatus
mailto:la-techsupport@dell.com


Chile (Santiago)
Country Code: 56
City Code: 2

Web Address
E-Mail Address
Sales and Customer Support

www.dell.com/cl
la‐techsupport@dell.com

toll-free: 1230-020-4823

China (Xiamen)
Country Code: 86
City Code: 592

Technical Support Web Address
Technical Support E-Mail Address
Customer Service E-Mail Address
Technical Support Fax
Technical Support – Dimension and Inspiron
Technical Support – OptiPlex, Lattitude and Dell 
Precision
Technical Support – Servers and Storage
Technical Support – Projectors, PDAs, Switches, 
Routers, etc
Technical Support – Printers
Customer Service
Customer Service Fax
Home and Small Business
Preferred Accounts Division
Large Corporate Accounts GCP
Large Corporate Accounts Key Accounts
Large Corporate Accounts North
Large Corporate Accounts North Government and 
Education
Large Corporate Accounts East
Large Corporate Accounts East Government and
 Education
Large Corporate Accounts Queue Team
Large Corporate Accounts South
Large Corporate Accounts West
Large Corporate Accounts Spare Parts

support.dell.com.cn
support.dell.com.cn/email
customer_cn@dell.com

592 818 14350
toll-free: 800 858 2969
toll-free: 800 858 0950

toll-free: 800 858 0960
toll-free: 800 858 2920

toll-free: 800 858 2311
toll-free: 800 858 2060

592 818 1308
toll-free: 800 858 2222
toll-free: 800 858 2557
toll-free: 800 858 2055
toll-free: 800 858 2628
toll-free: 800 858 2999
toll-free: 800 858 2955

toll-free: 800 858 2020
toll-free: 800 858 2669

toll-free: 800 858 2572
toll-free: 800 858 2355
toll-free: 800 858 2811
toll-free: 800 858 2621

Columbia Web Address
E-Mail Address
Technical Support, Customer Service, Sales

www.dell.com/co
la‐techsupport@dell.com

01-800-915-4755
Costa Rica Web Address

E-Mail Address
Technical Support, Customer Service, Sales

www.dell.com/cr
la‐techsupport@dell.com

0800-012-0231
Czech Republic (Prague)
International Access 
Code: 00
Country Code: 420 

Web Address
E-Mail Address
Technical Support
Customer Service
Fax
Technical Fax
Switchboard

support.euro.dell.com
czech_dell@dell.com

22537 2727
22537 2707
22537 2714
22537 2728
22537 2711

Denmark (Copenhagen)
International Access 
Code: 00
Country Code: 45

Web Address
Technical Support
Customer Service – Relational
Home/Small Business Customer Service
Switchboard – Relational
Switchboard Fax – Relational
Switchboard – Home/Small Business
Switchboard Fax – Home/Small Business

Support.euro.dell.com
7023 0182
7023 0184
3287 5505
3287 1200
3287 1201
3287 5000
3287 5001

Dominica Web Address
E-Mail Address
Technical Support, Customer Service, Sales

www.dell.com/dm
la‐techsupport@dell.com

toll-free: 1-866-278-6821

http://www.dell.com/cl
mailto:la-techsupport@dell.com
mailto:customer_cn@dell.com
http://www.dell.com/co
mailto:la-techsupport@dell.com
http://www.dell.com/cr
mailto:la-techsupport@dell.com
mailto:czech_dell@dell.com
http://www.dell.com/dm
mailto:la-techsupport@dell.com


Dominican Republic Web Address
E-Mail Address
Technical Support, Customer Service, Sales

www.dell.com/do
la‐techsupport@dell.com

1-800-156-1588
Ecuador Web Address

E-Mail Address
Technical Support, Customer Service, Sales 
(Calling from Quito)
Technical Support, Customer Service, Sales 
(Calling from Guayaquil)

www.dell.com/ec
la‐techsupport@dell.com

toll-free: 999-119-877-655-3355

toll-free: 1800-999-119-877-655-3355
El Salvador Web Address

E-Mail Address
Technical Support, Customer Service, Sales

www.dell.com/sv
la‐techsupport@dell.com

800-6132
Finland (Helsinki)
International Access 
Code: 990
Country Code: 358
City Code: 9

Web Address
E-Mail Address
Technical Support
Customer Service
Switchboard
Sales under 500 employees
Fax
Sales over 500 employees
Fax

support@euro.dell.com
fi_support@dell.com

0207 533 555
0207 533 538
0207 533 533
0207 533 540
0207 533 530
0207 533 533
0207 533 530

France (Paris) 
(Montpellier)
International Access 
Code: 00
Country Code: 33
City Codes: (1) (4)

Web Address
Home and Small Business
Technical Support
Customer Service
Switchboard
Switchboard (calls from outside of France)
Sales
Fax
Fax (calls from outside of France)
Corporate
Technical Support
Customer Service
Switchboard
Sales

Support.euro.dell.com

0825 387 270
0825 832 833
0825 004 700

04 99 75 40 00
0825 004 700
0825 004 701

04 99 75 40 01

0825 004 719
0825 338 339

55 94 71 00
01 55 94 71 00

Germany (Frankfurt)
International Access 
Code: 00
Country Code: 49
City Code: 69

Web Address
E-mail Address
Technical Support
Home/Small Business Customer Service
Global Segment Customer Service
Preferred Accounts Customer Service
Large Accounts Customer Service
Public Accounts Customer Service
Switchboard

support.euro.dell.com
tech_support_central_europe@dell.com

069 9792-7200
0180-5-224400
069 9792-7320
069 9792-7320
069 9792-7320
069 9792-7320
069 9792-7000

Greece
International Access 
Code: 00
Country Code: 49

Web Address
Technical Support
Gold Service Technical Support
Switchboard
Gold Service Switchboard
Sales
Fax

Support.euro.dell.com
00800-44 14 95 18
00800-44 14 00 83

2108129810
2108129811
2108129800
2108129812

Grenada Web Address
E-Mail Address
Technical Support, Customer Service, Sales

www.dell.com/gd
la‐techsuppo@dell.com
toll-free: 1-866-540-3355

http://www.dell.com/do
mailto:la-techsupport@dell.com
http://www.dell.com/ec
mailto:la-techsupport@dell.com
http://www.dell.com/sv
mailto:la-techsupport@dell.com
mailto:support@euro.dell.com
mailto:fi_support@dell.com
mailto:tech_support_central_europe@dell.com
http://www.dell.com/gd
mailto:la-techsuppo@dell.com


Guatemala Web Address
E-Mail Address
Technical Support, Customer Service, Sales

www.dell.com/gt
la‐techsupport@dell.com

1-800-999-0136
Guyana E-Mail Address

Technical Support, Customer Service, Sales
la‐techsupport@dell.com

toll-free: 1-877-270-4609
Hong Kong
International Access 
Code: 001
Country Code: 852

Web Address
Technical Support E-mail Address
Technical Support - Dimension and Inspiron
Technical Support - OptiPlex, Latitude, and Dell 
Precision
Technical Support - Servers and Storage
Technical Support - Projectors, PDAs, Switches, 
Routers, etc .
Customer Service
Large Corporate Accounts
Global Customer Programs
Medium Business Division
Home and Small Business Division

support.ap.dell.com
support.dell.com.cn/email

00852-2969 3188
00852-2969 3191

00852-2969 3196
00852-3416 0906

00852-3416 0910
00852-3416 0907
00852-3416 0908
00852-3416 0912
00852-2969 3105

India Dell Support Website

Portable and Desktop Support
Desktop Support E-mail Address
Portable Support E-mail Address
Phone Numbers

Server Support
E-mail Address
Phone Numbers

Gold Support Only
E-mail Address
Phone Numbers

Customer Service
Home and Small Business

Large Corporate Accounts

Sales
Large Corporate Accounts
Home and Small Business

support.ap.dell.com

india_support_desktop@dell.com
india_support_notebook@dell.com

080-25068032 or 080-25068034 or
your city STD code + 60003355 or

toll-free: 1-800-425-8045

india_support_Server@dell.com
080-25068032 or 080-25068034 or
your city STD code + 60003355 or

toll-free: 1-800-425-8045

eec_ap@dell.com
080-25068033 or your city STD code +

60003355 or
 toll-free: 1-800-425-9045

India_care_HSB@dell.com
 toll-free : 1800-4254051

India_care_REL@dell.com
toll free : 1800-4252067

1600 33 8044
1600 33 8046

http://www.dell.com/gt
mailto:la-techsupport@dell.com
mailto:la-techsupport@dell.com
mailto:india_support_desktop@dell.com
mailto:india_support_notebook@dell.com
mailto:india_support_Server@dell.com
mailto:eec_ap@dell.com
mailto:India_care_HSB@dell.com
mailto:India_care_REL@dell.com


Ireland (Cherrywood)
International Access 
Code: 00
Country Code: 353
City Code: 1

Web Address

Technical Support
E-mail Address
Business computers
Home computers
At Home Support
Sales
Home
Small Business
Medium Business
Large Business
E-mail Address
Customer Service
Home and Small Business
Business (greater than 200 employees)
General
Fax/Sales fax
Switchboard
U.K. Customer Service (dealing with U.K.only)
Corporate Customer Service (dial within U.K. 
only)
U.K. Sales (dial within U.K. only)

Support.euro.dell.com

dell_direct_support@dell.com
1850 543 543
1850 543 543
1850 200 889

1850 333 200
1850 664 656
1850 200 646
1850 200 646

Dell_IRL_Outlet@dell.com

204 4014
1850 200 982

204 0103
204 4444

0870 906 0010
0870 907 4499

0870 907 4000
Italy (Milan)
International Access 
Code: 00
Country Code: 39
City Code: 02

Web Address
Home and Small Business
Technical Support
Customer Service
Fax
Switchboard
Corporate
Technical Support
Customer Service
Fax
Switchboard

Support.euro.dell.com

02 577 826 90
02 696 821 14
02 696 821 13

 02 696 821 12

02 577 826 90
02 577 825 55
02 575 035 30

02 577 821
Jamaica E-mail Address

Technical Support, Customer Service, Sales 
(dial from within Jamaica only)

la-techsupport@dell.com
1-800-440-920

mailto:dell_direct_support@dell.com
mailto:Dell_IRL_Outlet@dell.com
mailto:la-techsupport@dell.com


Japan (Kawasaki)
International Access 
Code: 001
Country Code: 81
City Code: 44

Web Address
Technical Support - Dimension and Inspiron 
Technical Support outside of Japan - Dimension 
and Inspiron
Technical Support - Dell Precision, OptiPlex, and 
Latitude
Technical Support outside of Japan - Dell 
Precision, OptiPlex, and Latitude
Technical Support - Dell PowerApp™, Dell 
PowerEdge™, Dell PowerConnect™, and Dell 
PowerVault™,
Technical Support outside of Japan - PowerApp, 
PowerEdge, PowerConnect, and PowerVault
Technical Support - Projectors, PDAs, Printers, 
Routers
Technical Support outside of Japan - Projectors, 
PDAs, Printers, Routers
Faxbox Service
24-Hour Automated Order Status Service
Customer Service
Business Sales Division - up to 400 employees
Preferred Accounts Division Sales - over 400 
employees
Public Sales - government agencies, educational 
institutions, and medical institutions
Global Segment Japan
Individual User
Individual User Online Sales 
Individual User Real Site Sales
Switchboard

support.jp.dell.com
toll-free: 0120-198-26 

81-44-520-1435

toll-free: 0120-198-433

81-44-556-3894

toll-free: 0120-198-498

81-44-556-4162

toll-free: 0120-981-690

81-44-556-3468

044-556-3490
044-556-3801
044-556-4240
044-556-1465
044-556-3433

044-556-5963

044-556-3469
044-556-1657
044-556-2203
044-556-4649
044-556-4300

Korea (Seoul)
International Access 
Code: 001
Country Code: 82
City Code: 2

Web Address
Technical Support, Customer Service
Technical Support - Dimension, PDA, Electronics, 
and Accessories
Sales
Fax
Switchboard

Support.ap.dell.com
toll-free: 080-200-3800
toll-free: 080-200-3801

toll-free: 080-200-3600
2194-6202
2194-6000

Latin America Customer Technical Support (Austin, Texas, 
U.S.A.)
Customer Service (Austin, Texas, U.S.A.)
Fax (Technical Support and Customer Service) 
(Austin, Texas, U.S.A.) 
Sales (Austin, Texas, U.S.A.)
SalesFax (Austin, Texas, U.S.A.)

512 728-4093

512 728-3619
512 728-3883

512 728-4397
512 728-4600 or 512 728-3772

Luxemborg
International Access 
Code: 00
Country Code: 352

Web Address
Support
Home/Small Business Sales
Corporate Sales
Customer Service
Fax

Support.euro.dell.com
3420808075

+32 (0)2 713 15 96
26 25 77 81

+32 (0)2 481 91 19
26 25 77 82

Macao
Country Code: 83

Technical Support
Customer Service (Xiamen, China)
Transaction Sales (Xiamen, China)

toll-free: 0800 105
34 160 910
29 693 115



Malaysia (Penang)
International Access 
Code: 00
Country Code: 60
City Code: 4

Web Address
Technical Support - Dell Precision, OptiPlex, and 
Latitude
Technical Support - Dimension, Inspiron, and 
Electronics and Accessories
Technical Support - PowerApp, PowerEdge, 
PowerConnect, and PowerVault
Customer Service
Transaction Sales
Corporate Sales

Support.ap.dell.com
toll-free: 1800 880 193

toll-free: 1800 881 306

toll-free: 1800 881 386

toll-free: 1800 881 306 (option 6)
toll-free: 1800 888 202 
toll-free: 1800 888 213

Mexico
International Access 
Code: 00
Country Code: 52

Web Address
E-mail Address
Customer Technical Support
Sales
Customer Service
Main

www.dell.com/mx
la‐techsupport@dell.com

001-877-384-8979 or 001-877-269-3383
50-81-8800 or 01-800-888-3355

001-877-384-8979 or 001-877-269-3383
50-81-8800 or 01-800-888-3355

Montserrat E-mail Address
Technical Support, Customer Service, Sales

la‐techsupport@dell.com

Toll-free: 1-866-278-6822
Netherlands
Antilles
Netherlands 
(Amsterdam)
International Access 
Code: 00
Country Code: 31
City Code: 20

E-mail Address
Web Address
Technical Support
Technical Support Fax
Home/Small Business Customer Service
Relational Customer Service
Home/Small Business Sales
Relational Sales
Home/Small Business Sales Fax
Relational Sales Fax
Switchboard 
Switchboard Fax

la‐techsupport@dell.com
support.euro.dell.com

020 674 45 00
020 674 47 66
020 674 42 00
020 674 43 25
020 674 55 00
020 674 50 00
020 674 47 75
020 674 47 50
020 674 50 00
020 674 47 50

New Zealand
International Access 
Code: 00
Country Code: 64

Web Address
E-mail Address
Technical Support, Customer Service, Sales

Support.ap.dell.com
Support.ap.dell.com/contactus

0800 441 567

Nicaragua Web Address
E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/ni
la‐techsupport@dell.com

001-800-220-1377
Norway (Lysaker)
International Access 
Code: 00
Country Code: 47

Web Address
Technical Support
Relational Customer Service
Home/Small Business Customer Service
Switchboard
Fax Switchboard

Support.euro.dell.com
671 16882
671 17575
231 62298
671 16800
671 16865

Panama Web Address
E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/pa
la‐techsupport@dell.com

011-800-507-1264
Peru Web Address

E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/pe
la‐techsupport@dell.com

0800-50-669

http://www.dell.com/mx
mailto:la-techsupport@dell.com
mailto:la-techsupport@dell.com
mailto:la-techsupport@dell.com
http://www.dell.com/ni
mailto:la-techsupport@dell.com
http://www.dell.com/pa
mailto:la-techsupport@dell.com
http://www.dell.com/pe
mailto:la-techsupport@dell.com


Poland (Warsaw)
International Access 
Code: 011
Country Code: 48
City Code: 22

Web Address
E-mail Address
Customer Service Phone
Customer Service
Sales 
Customer Service Fax
Reception Desk Fax
Switchboard

support.euro.dell.com
pl_support_tech@dell.com

57 95 700
57 95 999
57 95 999
57 95 806
57 95 998
57 95 999

Portugal
International Access 
Code: 00
Country Code: 351

Web Address
Technical Support
Customer Service
Sales

Fax

Support.euro.dell.com
707200149

800 300 413
800-300-410 or 800-300 -411 or 

800-300-412 or 21-422-07-10
21-424-01-12

Puerto Rico Web Address
E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/pr
la‐techsupport@dell.com

1-877-537-3355
St. Kitts and Nevis Web Address

E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/kn
la‐techsupport@dell.com

toll-free: 1-866-540-3355
St. Lucia Web Address

E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/lc
la‐techsupport@dell.com

toll-free: 1-866-464-4352
St. Vincent and the 
Grenadines

Web Address
E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/vc
la‐techsupport@dell.com

toll-free: 1-866-464-4353
Singapore
International Access 
Code: 005
Country Code: 65

NOTE: The phone numbers in this section should 
be called from within Singapore or Malaysia only.

Web Address
Technical Support - Dimension, Inspiron, and 
Electronics and Accessories
Technical Support - OptiPlex, Latitude,
 and Dell Precision
Technical Support - PowerApp, PowerEdge, 
PowerConnect, and PowerVault
Customer Service
Transaction Sales
Corporate Sales

support.ap.dell.com
toll-free: 1 800 394 7430

toll-free: 1 800 394 7488

toll-free: 1 800 394 7478

toll-free: 1 800 394 7430 (option 6)
toll-free: 1 800 394 7412
toll-free: 1 800 394 7419

Slovakia (Prague)
International Access 
Code: 00
Country Code: 421

Web Address
E-mail Address
Technical Support
Customer Service
Fax
Tech Fax
Switchboard (Sales) 

support.euro.dell.com
czech_dell@dell.com

02 5441 5727
420 22537 2707

02 5441 8328
02 5441 8328
02 5441 8328
02 5441 7585

South Africa 
(Johannesburg)
International Access 
Code: 09/091
Country Code: 27
City Code: 11

Web Address
E-mail Address
Gold Queue
Technical Support
Customer Service
Sales

support.euro.dell.com
dell_za_suppor@dell.com

011 709 7713
011 709 7710
011 709 7707
011 709 7700

mailto:pl_support_tech@dell.com
mailto:dell_za_suppor@dell.com


Spain (Madrid)
International Access 
Code: 00
Country Code: 34
City Code: 91

Web Address
Home and Small Business
Technical Support
Customer Service
Sales
Switchboard
Fax
Corporate
Technical Support
Customer Service
Switchboard
Fax

Support.euro.com

902 100 130
902 118 540
902 118 541
902 118 541
902 118 539

902 100 130
902 115 236

91 722 92 00
91 722 95 83

Sweden (Upplands 
Vasby)
International Access 
Code: 00
Country Code: 46
City Code: 8

Web Address
Technical Support
Relational Customer Service
Home/Small Business Customer Service
Employee Purchase Program (EPP) Support
Technical Support Fax

support.euro.dell.com
08 590 05 199
08 590 05 642
08 587 70 527
020 140 14 44
08 590 05 594

Switzerland (Geneva)
International Access 
Code: 00
Country Code: 41
City Code: 22

Web Address
E-mail Address

Technical Support – Home and Small Business
Technical Support – Corporate
Customer Service – Home and Small Business
Customer Service – Corporate
Fax
Switchboard

Support.euro.dell.com
Tech_support_central_Europe@dell.com

0844 811 411
0844 822 844
0848 802 202
0848 821 721

022 799 01 90
022 799 01 01

Taiwan
International Access 
Code: 002
Country Code: 886

Web Address
E-mail Address
Technical Support - OptiPlex, Latitude, Inspiron, 
Dimension, and Electronics and Accessories
Technical Support - Servers and Storage
Customer Service
Transaction Sales
Corporate Sales

support.ap.dell.com
support.dell.com.cn/email

toll-free: 0080 186 1011

toll-free: 0080 160 1256
toll-free: 0080 160 1250 (option 5)

toll-free: 0080 165 1228
toll-free: 0080 165 1227

Thailand
International Access 
Code: 001
Country Code: 66

Web Address
Technical Support (OptiPlex, Latitude, and Dell 
Precision)
Technical Support (PowerApp, PowerEdge, 
PowerConnect, and PowerVault)
Customer Service
Corporate Sales
Transaction Sales

Support.ap.dell.com
toll-free: 1800 0060 07

toll-free: 1800 0600 09

toll-free: 1800 006 007 (option 7)
toll-free: 1800 006 009
toll-free: 1800 006 006

Trinidad/Tobago Web Address
E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/tt
la‐techsupport@dell.com

toll-free: 1-888-799-5908
Turks and Caicos Islands Web Address

E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/tc
la‐techsupport@dell.com

toll-free: 1-877-441-4735

mailto:Tech_support_central_Europe@dell.com
http://www.dell.com/tt
mailto:la-techsupport@dell.com
http://www.dell.com/tc
mailto:la-techsupport@dell.com


U.K.(Bracknell)
International Access 
Code: 00
Country Code: 44
City Code: 1344

Web Address
E-mail Address 
Customer Service Website

Sales
Home and Small Business Sales
Corporate/Public Sector Sales
Customer Service
Home and Small Business
Corporate
Preferred Accounts (500-5000 employees)
Global Accounts
Central Government
Local Government & Education
Health
Technical Support
Corporate/Preferred Accounts/PCA (1000+ 
employees)
Other Dell Products
General
Home and Small Business Fax 

upport.euro.dell.com
dell_direct_support@dell.com

support.euro.dell.com/uk/en/ECare/
form/home.asp

0870 907 4000
01344 860 456

0870 906 0010
01344 373 185
0870 906 0010
01344 373 186
01344 373 196
01344 373 199
01344 373 194

0870 908 0500

0870 353 0800

0870 907 4006
Uruguay Web Address

E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/uy
la‐techsupport@dell.com

toll-free: 000-413-598-2521
U.S.A. (Austin, Texas)
International Access 
Code: 011
Country Code: 1

Automated Order-Status Service
AutoTech (portable and desktop computers)
Hardware and Warranty Support (Dell TV, 
Printers, and Projectors ) for Relationship 
customers
Consumer (Home and Home Office) Support for 
Dell products
Customer Service
Employee Purchase Program (EPP) Customers 
Financial Services Web Address
Financial Services (lease/loans)
Financial Services (Dell Preferred Accounts 
[DPA])
Business
Customer Service
Employee Purchase Program (EPP)
Customer s Support for printers, projectors, PDAs, 
and MP3 players
Public (government, education, and healthcare)
Customer Service and Support
Employee Purchase Program (EPP) Customers
Dell Sales

Dell Outlet Store (Dell refurbished computers)
Software and Peripherals Sales
Spare Parts Sales
Extended Service and Warranty Sales
Fax
Dell Services for the Deaf, Hard-of-Hearing, or 
Speech-Impaired

toll-free: 1-800-433-9014
toll-free: 1-800-247-9362
toll-free: 1-877-459-7298

toll-free: 1-800-624-9896

toll-free: 1-800-624-9897
toll-free: 1-800-695-8133

www.dellfinancialservices.com
toll-free: 1-877-577-3355
toll-free: 1-800-283-2210

toll-free: 1-800-624-9897
toll-free: 1-800-695-8133
toll-free: 1-877-459-7298

toll-free: 1-800-456-3355
toll-free: 1-800-695-8133

toll-free: 1-800-289-3355 or
 toll-free: 1-800-879-3355
toll-free: 1-888-798-7561
toll-free: 1-800-671-3355
toll-free: 1-800-357-3355
toll-free: 1-800-247-4618
toll-free: 1-800-727-8320

toll-free: 1-877-DELLTTY
(1-877-335-5889)

mailto:dell_direct_support@dell.com
http://www.dell.com/uy
mailto:la-techsupport@dell.com
http://www.dellfinancialservices.com


U.S. Virgin Islands Web Address
E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/vi
la‐techsupport@dell.com
toll‐free: 1‐877‐702‐4360

Venezuela Web Address
E-mail Address
Technical Support, Customer Service, Sales

www.dell.com/ve
la‐techsupport@dell.com

0800‐100‐4752

http://www.dell.com/vi
mailto:la-techsupport@dell.com
http://www.dell.com/ve
mailto:la-techsupport@dell.com
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Getting Started with vFoglight

This chapter gives an introduction to the main dashboards and views in the vFoglight 
browser interface. It also describes the icons and other screen elements that you will see 
in most cartridges. 

Note vFoglight displays dynamic data that is updated regularly. For this reason it is not 
recommended that you use your browser’s Back and Forward buttons, as this may cause 
cached views to be displayed or result in an error message.

This chapter contains the following sections:

Logging in to vFoglight ................................................................................................................30
Introducing the Browser Interface................................................................................................30
Customizing vFoglight .................................................................................................................36
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Logging in to vFoglight
vFoglight runs in Internet Explorer 6 and 7 and Mozilla Firefox 2.0x and 3.0x. Your 
administrator will provide you with a link to the login page, where you enter your user 
name and password.

Figure 1

Introducing the Browser Interface
The following sections describe the main pages that you will see in a default 
installation. 

Note Your administrator may have configured vFoglight so that the actual displays are different 
from those in this section. The following information is intended only as a general guide.

Welcome Page
The first time that you log in to vFoglight, the Welcome page is displayed.
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Figure 2

The Welcome page contains helpful links to vFoglight Getting Started documentation 
and tips, vFoglight demonstrations, online help, and support links.

The Welcome to vFoglight page will remain your default home page unless you set a 
different home page. For instructions on changing your home page to a dashboard of 
your choice, see “Home Page” on page 39. The instructions are also on the Welcome to 
vFoglight page.

Screen Elements
This section describes the screen elements in vFoglight that you will see, regardless of 
which cartridges have been installed.

In addition to the display area and the two panels, a typical screen in vFoglight includes 
other elements, which are indicated in the graphic below.



32 vFoglight  
User Guide 
Figure 3

Figure 4

Navigation Panel
The navigation panel contains all the dashboards that are available for viewing by the 
current user. You can expand a module and select a dashboard to view it in the display 
area. This panel also provides access to the administration and configuration pages.

Note If you do not see any dashboards in the navigation panel, the user you signed in as may not 
have been assigned to a group. For details, see “Understanding Roles in vFoglight” on 
page 46.

Action Panel
The action panel contains the various actions that you can perform on the current 
dashboard. It also contains views and data that you can add to a dashboard or report that 
you are creating and provides access to the online help files.

Subsequent logins display either:
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• A home page that you have selected (for details, see “Screen Elements” on 
page 31).

• The first bookmark listed under Bookmarks; the default bookmark is the 
Welcome page (for details about creating bookmarks, see “Creating a Bookmark” 
on page 43).

Filter Icon

Select the Filter icon  to filter by role to control which group role can access 
different parts of vFoglight. By using the Filter by role feature you can enable users to 
access a particular dashboard or homepage through role assignments.

To control user access according to role:

1 Click the Filter icon for the Homes or Dashboards.

2 In the Filter dialog, select the checkbox next to each role you want to assign 
access to the particular Dashboard or Home page. 

3 Click Apply.

Note For more information on managing roles, see the vFoglight Administration and 
Configuration Guide.

Close Arrow
The Close arrow is used to conserve space on the display area. Click the arrows to: 

expand  the display area and collapse  the navigation and action panels.
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Header
The header contains the following icons:

Tabs
The following tabs are available in the action panel:

• General tab—contains a number of actions that you can perform on the current 
dashboard or report. 

• Help tab—provides access to the online help files and a search field for the help.

• Design tab—available on any non-portal page to properly-authenticated users 
such as those with the dashboard designer role. The Design tab shows a 
hierarchical list of all views of a dashboard, definition details, and a context editor 
that is useful for debugging. 

When you select a particular view you can:

• See the definition of the current view 

• Click Inspect  to analyze the view in the definitions editor. 
• View the current run-time values that are available in the context for that view. 
Note Inspecting existing object types is accessible from the WCF designer. For more 

details on the dashboard definitions, see the Web Component Guide. 

Figure 5

When you select Create Dashboard or Create Report, two more tabs appear:

• Views tab—contains a list of views that can be added to a dashboard or report that 
you are creating.

Function Description

Click the product name to take you back to the Home page.

 username
The user name of the current user.

 Sign Out
Logs out the current user and reclaims all resources that it 
used in the current session. This is the recommended way 
to exit vFoglight, rather than just closing the browser.
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• Data tab—contains a list of data objects that can be displayed in chart or table 
format by dragging them into the display area.

Display Area
In the display area you can view current dashboards and reports, as well as create new or 
custom dashboards and reports. See “Creating a Custom Dashboard” on page 76 and 
“Creating a Custom Report Template” on page 213 for more information.

Note You can maximize the size of the display area by closing the navigation and action panels.

The example below shows two views and two metrics charts, which were dragged into 
the display from the Views and Data tabs in the action panel. 

Figure 6

Footer
The footer contains the following links:

Copyright Vizioncore Inc. Links to the copyright page on the Vizioncore 
web site.
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Delete Icon
A bookmarked page provides easy access to navigation items. Click the Delete icon 
beside the bookmark to remove it. See Chapter 2, “Deleting a Bookmark in the 
Bookmarks view”.

Zonar and Time Range
vFoglight uses a bar chart to indicate the average of all collected metrics within the 
range of the zonar. See Time Range and Zonar in Chapter 3.

Time Range Freeze Control
The Time range function enables you to freeze the vFoglight interface data at a 
specified time range. See “Freezing a time range” on page 52.

Customizing vFoglight
This section describes the areas where you can customize vFoglight according to user 
preference settings, home pages, and themes.

User Preferences
The User Preferences dashboard is under Configuration in the navigation panel. The 
options in this page enable you to change a number of settings in vFoglight. The choices 
you make here are saved with your user profile.

Contact Us Links to local contact information on the 
Vizioncore web site.

About Displays product, contact, and support 
information.
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Figure 7

The following table describes the User Preferences settings.

Setting Description or Options

Language This setting controls the language that is used in the 
vFoglight browser interface. The default is the 
language set in the browser.

Refresh Interval To ensure that the views display current data, vFoglight 
automatically refreshes the pages. This setting enables 
you to choose the length of the interval. The default is 
300 seconds.

Time Zone The time zone used in a vFoglight session is 
determined when you log in and is the local time zone 
for your server. You can use the User Time setting to 
choose another time zone. 

Time Range This setting controls the default time range for the 
views. The default setting is Last 4 Hours.



38 vFoglight  
User Guide 
Page Flow Overrides
System views are linked to each other through pre-defined configurations. In some 
cases, you may want to link a System view to a User view instead. The Page Flow 
Override option enables you to make this change. Every link on the page or view 

Themes Themes are format settings that affect the look of 
dashboards and reports. You can override this setting 
for individual dashboard and reports using the Themes 
options in the action panel. For details, see “Themes” 
on page 39.
You can only change the look of your PDF reports 
(Create PDF) in User Preferences.
To change the theme used in generating (printing) 
reports to color, choose Report (Color) for the Print 
theme.

PDF Defaults These settings enable you to set the page size and 
orientation of PDFs.

Advanced Page Flow Overrides: These settings override the pre-
defined links between System views. For more 
information, see “Page Flow Overrides” on page 38.

Data Sources: These settings determine the data source 
that vFoglight uses for data and schemas.

Disable User Interaction Persistence: If you select this 
option, changes that you make in the vFoglight browser 
interface are not kept with your user profile.

Setting Description or Options
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indicated in the Map field that points to a target view will be redirected instead to the 
view indicated in the To field.

Caution This requires knowledge of how views are created, and should only be set by a view or 
dashboard designer. For more information, see the Web Component Guide.

Home Page
You can choose any dashboard to be your personal home page. Other dashboards can 
also be designated as home pages by a dashboard developer. These are listed under 
Homes in the navigation panel.

To set your personal home page:

1 Select a dashboard under Homes in the navigation panel on the left. Choose the 
dashboard that is most appropriate for your needs.

2 Click Make this my home page in the actions panel. 

The dashboard is listed under Homes in the navigation panel and will be the first 
page that is displayed every time you log in to vFoglight.

If you later choose another dashboard as your home page, it replaces the previous one.

Note You can have multiple homes. When you mark something as a home page, it becomes the 
default home and it is added to the list of possible homes. For example, if you add vFoglight 
Data Management as your home page, it is added to the default set of homes for your user 
role, and becomes your "current" home. If you log out and log back in, you will access 
vFoglight Data Management.

Themes
The Themes options allow you to control the look-and-feel for your UI such as the 
appearance of vFoglight dashboards and reports. You set these options in the User 
Preferences page, but you can override them by using the same options under Themes in 
the action panel.
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The following table describes the options.

Note To print PDF reports in color, the theme must be changed in the User Preferences 
dashboard. Go to Configuration > User Preferences and choose Report (Color) for the 
Print theme. See “User Preferences” on page 36. 

Option Result

Application - Default White background in all dashboards and views

Monitoring - Default Dark blue background in all dashboards and views

Report (Monochrome) Reports are printed in black and white

Report (Color) Reports are printed in color
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Navigation in vFoglight

This chapter provides an introduction to the navigation tools used in the vFoglight 
browser interface and also an introduction to roles. 

This chapter contains the following sections:

Introduction to Navigation............................................................................................................42
Understanding Roles in vFoglight................................................................................................46
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Introduction to Navigation
In addition to the navigation panel, other navigational aids are located in dashboards and 
views. These include:

• Data views (charts, tables, cylinders) provide links to more detail about the data 
that is selected (service > service detail) or to diagnose a problem (alarm > alarm 
detail).

• Selector views (trees, drop-down lists) allow you to change the context (domain, 
host, etc.) of what you are viewing.

• Navigation views (links box, labels) allow you to navigate from one part of the 
interface to another.

Note In addition to these types of links, vFoglight also displays additional information from within 
a view. For more information, see “Tooltips, Dwells, and Popups” on page 50.

Breadcrumb Trail
The name of the current view is displayed in bold letters at the top of the view:

Figure 1

If you move directly from one view to another, the names of the previous views are 
displayed in a breadcrumb trail. The names are links back to the previous views and are 
displayed as non-bolded text.

Caching
vFoglight displays dynamic data that is regularly updated. For this reason it is preferable 
not to use your browser’s navigation buttons, as this may display cached views or result 
in an error message. Use the links in the display area instead.

vFoglight remembers where you have been by display area. If you leave a dashboard 
and then return to it, you see the last view that was displayed.

Note This tracking is based on your user ID and is saved on the server.
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Table Links
Content in tables can be links to views. For example, in a table that contains a list of 
hosts, each host name may be a link to a page with more information about that host.

Tables also have icons and functions for sorting, paging, and filtering. These are 
discussed in “Working With Tables” on page 91.

Icon Links
Icons may be links to other views or dashboards. Linked icons and non-linked icons 
look the same. When you move your mouse over a linked icon, the pointer changes to a 
hand. For more information, see “Icons” on page 94. 

Bookmarks
Bookmarks are useful for keeping track of dashboards and views that you intend to 
revisit or access quickly, without having to drill down several levels. A bookmark can 
be a snapshot of data that is “frozen” at a specific point in time, or it can be updated with 
current data when you access it. For example, you can create a bookmark to quickly 
access a specific drilldown or view to be saved for viewing later such as the System 
Overview on a particular host last Wednesday.

The Bookmarks section of the navigation panel lists all the bookmarks that you have 
created. When you select a bookmark, it appears in the display area. You can then do the 
following:

• email a link to this dashboard

• make it your home page

• print it

Creating a Bookmark
To bookmark a dashboard:

1 Locate and display the dashboard that you want to bookmark.

2 In the action panel, select Bookmark.

The Bookmark dialog appears.
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3 Type a unique name in the Name field.

4 Select one of the Keep for options to indicate whether you want to keep the 
bookmark indefinitely or for a specified number of days. If you choose the latter, 
type the number of days in the text field.

5 Select Send an email with a link to this bookmark if you want to send someone 
a link to the new bookmark. 

6 Select Preserve state if you want to keep the context input of the dashboard.

For example: At the time when you bookmark a dashboard, it has a drop-down in 
which HostX is selected. When you later view the bookmarked dashboard, HostX 
will still be selected.

7 If you have selected Preserve state, the Preserve time range check box becomes 
available. Select this check box if you want to keep the bookmark’s current start 
and end times. Otherwise, if the time range is relative (e.g. Last 24 Hours), the 
bookmarked view will show metrics for the default time period when you display 
it.

8 Type a description; this is optional.

9 Click OK to save the bookmark. 

10 If you selected the email option in step 5 above, an email window opens, 
containing a link to this bookmark. Complete the required fields and click Send.

The new bookmark is now listed under Bookmarks at the top of the navigation panel.

Viewing a Bookmark
To display a bookmarked dashboard, expand the Bookmarks area in the navigation 
panel and select the bookmark you want to display. 
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Emailing a Link to a Bookmark
This option is also available when you create a bookmark.

To email a link to a bookmark:

1 In the Bookmarks area of the navigation panel, select a bookmark to display it.

2 Select Email from the action panel. 

An email window opens, containing a link to the bookmark.

3 Fill in the required information and click Send.

Changing Bookmark Properties
You can change the expiry time and the description of an existing bookmark.

To change the properties of a bookmark:

1 In the navigation panel, select the name of a bookmark you want to edit.

2 In the action panel, click Properties to open a drop-down menu. 

3 Select Edit bookmark properties under Actions.

The Bookmark dialog appears.

4 Make your changes and click OK.

Deleting a Bookmark in the Bookmarks view
You can remove a bookmark in the navigation panel. 

To delete a bookmark in the navigation panel:

1 Place the cursor over the delete icon  beside the name of the bookmark.

The icon turns red.

2 Click the delete icon . 
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3 On the confirmation dialog, click Delete to delete the bookmark.

Understanding Roles in vFoglight
vFoglight controls access to dashboards and views by means of roles. A vFoglight 
administrator assigns users to groups and then assigns roles to those groups. When you 
try to access a dashboard or view, the roles of the groups to which you belong are 
matched against the relevant roles and the allowed roles that were set for that dashboard 
or view. 

Relevant roles control which dashboards and views are listed in the navigation and 
action panels. Allowed roles control which dashboards and views a group can access, 
whether or not they are listed in the panels. If a view has no relevant roles marked, 
vFoglight assumes it is relevant to all roles. If a view has no allowed roles marked, 
vFoglight assumes that all roles are allowed to see it.

To illustrate how roles work, suppose you belong to a group that has been assigned the 
roles of Advanced Operator and Dashboard User. When you log in to vFoglight, the 
navigation panel lists only the dashboards for which those roles are relevant roles. In 
some dashboards, one or more views may not be available because your roles have not 
been set as allowed roles for them.

You can filter the dashboards that are listed in the navigation panel by clicking the filter 
icon to the right of Dashboards or Homes to display a list of relevant roles, de-selecting 
one or more roles, and clicking Apply.

The roles that are built in to vFoglight are designed to have the following permissions:

Role Permissions

Dashboard User Access to basic dashboards.

Operator Access to basic dashboards. Operators can also access 
dashboards like Services, Agents, and Host Table.

Advanced 
Operator

Extends Operator to include administrative dashboards like the 
Service Builder and the Application Builder.

Dashboard 
Designer

Access to the dashboard design options available under 
Configuration > Definitions.
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See the vFoglight Administration and Configuration Guide for additional information 
on users, groups and roles. 

Cartridge 
Developer

Ability to load cartridges, create rules and derived metrics, and 
perform other tasks related to creating a cartridge.

Administrator Access to all administrative functions, particularly the ability 
to deploy, create, and control agents.

Role Permissions
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Working with Dashboards

This section describes how to work with vFoglight dashboards, and provides a 
description of the common elements that are found on most dashboards. 

Note For information about the options in the Administration module, see the Administration and 
Configuration Guide.

For information about the Definitions dashboard, see the Web Component Guide.

For information about cartridge dashboards, such as the dashboards for the Cartridge for 
Operating Systems, see the User Guides for those cartridges.

This chapter contains the following sections:

Introduction to Dashboards .........................................................................................................50
Common Views ...........................................................................................................................58
Creating a Custom Dashboard ....................................................................................................76
Viewing Dashboard Properties ....................................................................................................89
Working With Tables....................................................................................................................91
Printing Views..............................................................................................................................92
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Introduction to Dashboards
vFoglight displays monitoring data in views that group, format, and display it. 

Dashboards are top-level views that do not need to receive data from other views. 
Dashboards usually contain a number of lower-level views. The dashboards supplied 
with vFoglight, as well as those created by users, are available in the navigation panel.

Lower-level views in vFoglight can be added to dashboards or can be accessed by 
drilling down from a dashboard. They receive and display data directly from the 
vFoglight Management Server or from other views. Some views filter or select data that 
appears in other views in the same dashboard. Some are tree views with expandable 
nodes for selecting servers, applications, or data.

Display Functions
vFoglight provides various ways in which you can modify a view or display the data in 
a different format. For example, you can select metrics, select a data object to update a 
view, or change the time range. These functions are available as drop-down lists or table 
filters, in dialogs, or through menus.

This section describes the following functions that you can use to modify a view:

• “Tooltips, Dwells, and Popups” on page 50

• “Time Range” on page 51

• “Splitter” on page 56

• “Columns” on page 56

• “Drop-Down Lists and Trees” on page 56

Tooltips, Dwells, and Popups 
Different types of smaller views provide additional detail about an element in a view. 
Examples of these views are:

• A tooltip element describes what it represents when you hold the cursor over a 
status icon. Tooltips also appear when you hold the cursor over a line in a chart.

• A dwell displays additional information about the item when you hold your 
cursor over a line in a table. 

• A popup displays additional information and options if you click a line in a table.
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Tooltips and dwells disappear when you move the mouse, but a popup remains open 
until you close it by clicking outside it or clicking the close icon  in the corner. You 
can also maximize some popups by clicking the maximize icon  in the upper right 
corner.

Figure 1

Time Range
The time range at the top of a dashboard indicates the current time range for all the 
views on the page. If some of the views have independent time ranges, the time range is 
not displayed. 

By default, the time range in a dashboard is displayed in real time. You can “freeze” the 
time range so that the views are fixed at a certain range. This is helpful for diagnostic 
purposes when you do not want to receive new data. For further details, refer to 
“Freezing a time range” on page 52.

Changing the time range in a dashboard affects all the views in the dashboard. If an 
individual view in a dashboard has a different time range, that takes precedence over the 
time range for the dashboard.

Clicking the time range opens a menu where you can select another time range or select 
Custom to specify a range.

Standard Time Ranges
The time range menu lists the standard ranges. When you select one of these options, all 
the views in the dashboard are automatically updated, unless they were created with a 
time range other than the global one.

Custom Time Ranges
To set a specific time range, you select Custom from the time range menu to open the 
Custom Time Range dialog. Initially, only the Zonar is displayed. Clicking the down-
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arrow beside Precision Control expands the dialog to display the Precision Control 
options. Clicking the browse button  to the right of the date fields displays the 
calendars.

Figure 2

The Precision Control section contains the following settings:

• From and To date and time fields (see page 55)

• Earliest Available and Current Date check boxes (see page 55)

• Calendars (see page 55)

• Granularity options (see page 55)

Except for granularity, changing any of these settings automatically updates the views.

The time range for a summary view is likely to be different from the time range for a 
detail view. Therefore, the time range that you select affects only the current view and 
drill-downs from it; it does not affect higher-level views.

Freezing a time range
By default, the time range on a dashboard is displayed in real time. You can tell this at-
a-glance if the word Now is shown in the time range display.
Image 3
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You can disconnect from real time and “freeze” a dashboard at a specified time range. 
When this occurs, the views on the dashboard will not receive any new data. 

To freeze a time range:

1 Select the dashboard for which you want to freeze the time range. 

2 Click the  icon to the left of the displayed time range at the top right of the 
dashboard. 
Tip When you hover over the icon a popup indicates if the time range is real time or frozen: 

The time range is set and the icon changes to . 

Hover over the icon to display the message: Time range is in the past, click to 
switch to real time.

3 If you later refresh a dashboard, you may notice that the time range remains fixed 
even though the time that is displayed in the Zonar changes. For example, in the 
screen shot below, the time range ends at 9:50 while the current time is 10:12.

To unfreeze a time range:

• Click the  icon. 

The time range changes to end at the last monitoring time range that you used (for 
example, the last four hours).

Diagnostic Time Range
In vFoglight versions 3.0, if you drilled down the path for an old alarm, all of the 
drilldowns applied to the current time, not the time that the alarm occurred. In versions 
3.0.1 (or later), the time-sync function called the diagnostic time range was added to 
drill-downs. 

The diagnostic time range shows a 4 hour window, where the alarm time range is placed 
3 hours into the window (e.g. 3 hours prior and one hour past the alarm). The diagnostic 
time range stays frozen until you unfreeze (toggle) the time range.
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The diagnostic time range function works as follows:

• For any alarm that is not in the current time range, if you click on a drill down, 
places you into a diagnostic time range. 

• Some drill-downs indicate that you are in diagnostic time range as shown in the 
dialog box below. 

Note The diagnostic time range function is not available for all drill-downs.

Zonar
At the top of the dialog is a sliding bar called the Zonar. When you place your mouse 
over the bar, a popup displays the current date, time, and time range. 

Figure 4

Click in the middle of the range to drag the Zonar to the left or the right. The start and 
end times of the range changes, but keeps the same time period. You can increase or 
decrease the time period by dragging the sides of the range. As you drag, the popup 
displays the new range.

As you drag the edges of the range, the Zonar scale automatically adjusts, increasing or 
decreasing the units of time. For example, in the above screen shot, the time range is 
four hours. If you drag the left edge of the range as far as you can, the range increases by 
about eight hours. When you stop dragging, the scale automatically adjusts and you can 
then drag the edge further.

If you drag the right edge of the range when the time range is in real time (the word Now 
is shown in the time range display), the range will persist for the duration (for example, 
4.5 hours) and not to the specific date/time to which it was set. 
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Precision Control
The Precision Control section is collapsed when the dialog opens. To display it, click 
the down arrow to the right of Precision Control.

Date and Time Fields
Type specific dates and times for the range. If you enter an incorrect date or time, a red 
exclamation mark is displayed at the right of the field and you cannot apply the changes. 
You can also use the Earliest Available or Current Date check box to set the time range.

Calendars
If you prefer to use a calendar to select dates, click the browse button  to the right of 
the date and time fields to display start-date and end-date calendars.

Granularity
Granularity controls the size of the metric intervals. The default option is Raw, which 
displays the actual collected data points. The Auto option uses intervals that are sized 
according to the time range. For example, a one-hour range has five-minute intervals, 
while a one-week range has one-hour intervals. If you choose an option other than the 
default, click Apply to update the views.

Caution If you set too large an interval, there may not be enough points to plot on a chart. For 
example, if you only have one day of data, an interval of six months will result in a single 
point. If an interval is too small, there may be too many data points to display if the chart 
is small.

The maximum and minimum values of a metric are actual numbers, while data points 
inside an interval are averaged. Agents may report their data at uneven intervals. 
vFoglight sets the data to be plotted in evenly-spaced intervals using data collected from 
any number of agents. 

To do this, the data points inside the interval are averaged. This has the effect of evening 
out the maximum and minimum values if an interval contains more than one real data 
point. The maximum and minimum values of a metric are based on real data and not an 
averaged value. These values are often plotted as markers on the chart. Therefore the 
averaged values on the plotted curve or bar may not match the real values of the 
markers.
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Splitter 
Composite views may have a moveable bar, or splitter, between the two views. It can be 
either horizontal or vertical. You can move it back and forth to resize the views on either 
side.

Figure 5

The splitter has two arrows facing in opposite directions. When you click an arrow, the 
view it is facing collapses, the splitter moves to the edge of the remaining view, and 
only the other arrow is visible. You can restore the hidden view by clicking the other 
arrow.

Columns 
When you are creating a custom dashboard or report, you can choose one of the options 
under Columns under the General tab in the action panel to divide the display area into 
one, two, or three columns. 

Figure 6

Drop-Down Lists and Trees
Drop-down lists are views that change the context of other views, such as those in the 
same container view. When you select an item from a drop-down list, the view is 
refreshed with new data. For example, a view may contain a drop-down list of metrics, a 
chart, and a table. Selecting a different metric changes the context of the page, and the 
chart and table are updated accordingly.

A drop-down list displays a list of single options. A tree expands to display a hierarchy 
of options. They have the same effect on the context.
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Customizer
The Customizer icon is available for charts and tables. 

Note To access the customizer it needs to be enabled. Customizers are not enabled by default.

If the Customizer icon  is enabled you can:

• Change the chart type dynamically. See “Changing the Chart Type” on page 81.

• Export charts and tables to PDF or CSV format. See Exporting Data from Charts 
and Tables.

Exporting Data from Charts and Tables
The option to export data to CSV and PDF format is available for charts and tables.

For example, you can create new graphs using drag and drop metrics onto a dashboard, 
and then export the data to CSV output. Therefore, you can create multiple metrics, set a 
time range, export to CSV, and then open the data in Excel.

To export charts to CSV or PDF format:

1 Navigate to the chart or table you want to export. 

1 Click the Customizer icon  in the top right hand corner of the table or chart.

2 Choose either Export as CSV or Export as PDF. 

3 If you chose Export as CSV, choose if you want to open or save the file.
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Common Views
vFoglight makes use of common views in most of the standard dashboards. Using 
common views in pre-declared dashboards is an effective way to enable and create easy 
workflows. Examples of views used in most of the dashboards include the Alarm list 
display and the Host summary display.

Alarm List 
When a list of alarms is shown, the same alarm list view appears as a popup or fixed 
path depending on the navigation path.

Figure 7

The Alarm list view displays a summary of alarms by severity level at the top. The 
counts in the title are for outstanding alarms. The Outstanding Alarms view shows 
Ack’ed and Cleared columns containing a Y (Yes) or N (No) to indicate the 
Acknowledgement status. While the Alarms list also shows cleared alarms, the cleared 
alarms are not included in the count for outstanding alarms. Cleared alarms appears 
dimmed out. Cleared alarms can be filtered out. You can also apply a filter to the alarm 
list using other criteria, as described in “Filtering the Alarms View” on page 62. 

Managing Alarms
You can select an individual alarm and once selected, choose to take action on the alarm 
that has been fired such as Acknowledge or Clear. For further information, refer to 
either “Acknowledging an Alarm” on page 63 or “Clearing an Alarm” on page 65. 

The Alarm list view allows you to choose from four different perspectives on alarms:

• Current Alarm(s)

• Error Instance(s)

• Related Host(s)
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• Related Agent(s)

Current Alarm(s)
By default, you see the list of alarms with the ability to sort the alarms by different 
elements (Severity, Time, Ack’ed, Cleared, Host, Instance, Message, Origin, Agent, 
Agent Type). 

Error Instance(s)
The Error Instances option lists the agents containing data that triggered an alarm in the 
Outstanding Alarms table. For each error instance triggered, it indicates its state of 
health, number of each type of alarm, and its health history. 

In the example shown below, the alarms are grouped according to their source (Long 
Name). 

Figure 8

Drilldowns
The following drilldowns are available from the Alarm Source(s) table. 

Select To 

Long Name see the “Instance” on page 66. 
If you select an agent, you also are notified if the agent is 
running and the overall health state of the agent (Broken or 
OK ). 

Health icon see links to:
• health of all alarm sources
• health of current alarm source
• all outstanding alarms for that alarm source 

Alarms see a list of alarms for that alarm source



60 vFoglight
User Guide
Related Host(s)
A convenient way to isolate issues related to systems is to show the alarms organized by 
the originating host. You can expand each host to see the source of the alarm. In the 
example below, all alarms are coming from a single host instance.

Figure 9

Drilldowns
The following drilldowns are available from the Related Host(s) table. 

Hover over the Health History bar to see the percentage and duration of time that the 
alarm source was at a certain severity level.

Health History Hover over the Health History bar to see the percentage and 
duration of time that the alarm source was at a certain severity 
level.

Select To 

Long Name see the “Instance” on page 66. 
If you select a host, the Host Summary as described on 
page 74 is displayed. 
If you select an agent, you also see if the agent is running and 
the overall health state of the agent (Broken or OK). 

Health icon see links to:
• health of all alarm sources
• health of current alarm source
• all outstanding alarms for that alarm source 

Alarms see a list of alarms for that alarm source

Select To 
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Related Agent(s)
A useful way to understand which agent is causing an alarm to fire is to show alarms 
organized by the agent that collected the data. You can expand each agent node to see 
where the agent is gathering data.

The example below shows that the Application Monitor agent is firing fatal alarms and 
critical alarms are coming from the Windows System agent.

Figure 10

Drilldowns
The following drilldowns are available from the Related Agent(s) table. 

Hover over the Health History bar to see the percentage and duration of time that the 
alarm source was at a certain severity level.

Select To 

Long Name see the “Instance” on page 66. 
If you select an agent, you also are notified if the agent is 
running and the overall health state of the agent (Broken or 
OK). 

Health icon see links to:
• health of all alarm sources
• health of current alarm source
• all outstanding alarms for that alarm source 

Alarms see a list of alarms for that alarm source
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Filtering the Alarms View
You can filter the list in the Outstanding Alarms view using one or more of the 
following criteria:

• Severity (Undefined, Normal, Fire, Warning, Critical, Fatal)

• Time (range, earliest available, current date)

• Is Acknowledged (true or false)

• Is Cleared (true or false)

• Host name

• Instance

• Message

• Origin (source of an alarm)

• Whether or not the alarm has been acknowledged (True or False)

• Agent name

• Agent type

To filter the alarm list:

1 Click Alarm Filter Not Set in the title bar of the view. (If a filter has already 
been set, the link will say Alarm Filter Applied.). The Alarm Filter Not Set/
Applied dialog opens.
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2 Select or enter your filter criteria. If you want to use a calendar to choose a date or 
date range, click the browse button  to display two calendars. The dates that 
you choose in the calendars appear above in the From and To fields.

3 If applicable, select the Use Regex checkbox to search for a regular expression 
(regex). Regex is a special text string that describes a search pattern using 
wildcards. For example: .*\.txt$

4 Click Find. 

The table refreshes to display the filtered alarm data.

Hiding Columns in the Alarms View
You can hide any of the columns in the Outstanding Alarms view.

To hide columns:

1 Click the edit icon ( ) above the table. 

A popup displays a list of the columns in the table.

2 De-select the columns that you want to hide and click Apply. 

The de-selected columns are removed from the table.

Acknowledging an Alarm
The Ack’ed and Cleared columns in the Outstanding Alarms view indicates if an alarm 
has been acknowledged. If an alarm has not yet been acknowledged, the column 
displays N. When you acknowledge an alarm, the column appears with a Y. The name 
of the person who acknowledged it is also indicated. This information is also stored in 
an audit report. You also have the option of adding a note (see “Alarm Notes” on 
page 70) to indicate an alarm has been acknowledged.

To acknowledge an alarm:

1 In the Alarms view, select the alarm(s) in the alarm table that you want to 
acknowledge. 

2 To acknowledge the alarm from the Outstanding Alarms list, click Acknowledge 
at the top of the table: 
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The Alarm status in the Ack’ed column changes to Y to indicate the alarm has 
been acknowledged. If you hover over the Y, your user name appears in the By 
user column for that alarm. 

Note Alternatively, you can acknowledge an alarm using the Alarm Details dialog box.

a In the Outstanding alarms view, click N beside the alarm that you want to 
acknowledge.

The Alarm Details dialog box appears.
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b Click Acknowledge. 

Your user name appears in the Ack’ed column for that alarm. The Alarm status in 
the Ack’ed column changes to Y to indicate the alarm has been acknowledged.

If you want to acknowledges the current alarm and all consecutive alarms fired by 
the same rule on the same instance, click Acknowledge Until Normal. This 
option is available to an outstanding (not-yet-cleared) alarm only.

You can also apply a note to alarm. See “Alarm Notes” on page 70.

Clearing an Alarm
The Alarms table list all alarms including cleared alarms in a given time range. Cleared 
alarms are shown by default. You can filter out cleared alarms using the alarm filter. See 
“Filtering the Alarms View” on page 62. 

As a visual cue, cleared alarms appear dimmed out. This applies to all alarms that are 
cleared regardless of the time range. You can add a new note (see “Alarm Notes” on 
page 70) or acknowledge an alarm (see “Acknowledging an Alarm” on page 63), even 
though it is cleared. The Cleared column in the Outstanding Alarms view indicates the 
status on whether a cleared alarm was not acknowledged (N) or the cleared alarm has 
been acknowledged (Y).

If the same condition that caused the alarm to fire occurs again in the next sampling 
interval, the alarm will reappear in this table.

To clear an alarm:

1 In the Outstanding Alarms view, click the check box beside the alarm that you 
want to clear.
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2 Click Clear above the table. 

The Alarm Status in the Cleared column changes to indicate the alarm has been 
cleared and the cleared alarm is dimmed out. The alarm is removed from the 
count for outstanding alarms.

Alternatively, you can clear an alarm from the Alarms Details dialog box. 

Instance
When you select the instance of the alarm (e.g. in the Alarm list when looking at a list of 
Outstanding alarms, or when looking at alarms grouped by Alarm source), a common 
health summary for the data that triggered the alarm appears:
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Figure 11

The health summary:

• shows the number of alarms by severity and the overall health of the selected 
alarm source. 

• provides links to the agents and host for the alarm source. 

• provides a list of related views that show quick drilldowns to help identify the 
root cause. This list is based on the views that match the type of the alarm source. 
The related views are often provided by cartridges. If no related views are 
available, then the default views (e.g. Data Browser, Summary) are provided.

Alarm Details
The Alarm Details summary is shown when an alarm message, severity icon, alarm 
time, or agent type is selected. 

You can check alarm details to view more information about an alarm in the alarms 
table. For example, if you are concerned about a particular alarm, click the alarm 
severity in the alarms table to view the alarm details. On the alarm details dialog box 
you can view the table that illustrates how the alarm has changed state in the current 
time range.

The Alarm Details dialog box shows alarms related to the current alarm in the given 
time range, acknowledgement information of these alarms (such as whether an alarm 
has been acknowledged or is not acknowledged), clearing information of these alarms, 
and any alarm notes added to these alarms.
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The alarm details view also shows the full alarm history. This includes all consecutive 
alarms fired by the same rule on the same instance regardless of the time range. The 
default for 'consecutive' is 5 seconds. 

Figure 12

Figure 13

Drilldowns
The following drilldowns are available from the Alarm Details with Actions popup. 

Select To 

Instance The data that triggers an alarm. See “Instance” on page 66. 

Host see the Host Summary as described on page 74.

Agent see the “Instance” on page 66, as well as an indication as to the 
status and state of the agent (Broken or OK).

Agent Type see the “Instance” on page 66, as well as an indication as to the 
status and state of the agent (Broken or OK).
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Origin (by rule) displays the origin of the alarm. You can access links to:
• Rule Details—to view a short synopsis about the rule
• Edit Rule—to edit the rule definition
• Rule Help—to display online help about the rule 
To edit a rule, select the rule name and then select Edit Rule 
Definition. The Rule Editor appears. For further information 
on editing rules, refer to the vFoglight Administration and 
Configuration Guide.

Default Drilldown see the view associated with the rule that is listed in the by 
Rule field. From the view, you can then drill down to see 
additional details. 
If a view is not available for a rule, N/A is displayed. 

Severity and 
Message at

show the date and time when the alarm severity occurred 
along with a description.

History tab view a history of alarms for the:
• Created Time (time when the alarm occurred)
• Sev (alarm severity when the alarm occurred)
• Dur: duration of length of time that the alarm was in the 

associated state.
• Acknowledgment Info (indicating the status if the alarm 

was acknowledged or not, and by whom). For further 
information, refer to “Acknowledging an Alarm” on 
page 63.

• Clearing Info (indicating the status if the alarm has been 
cleared or not, and message). For further information, 
refer to “Clearing an Alarm” on page 65.

• Notes. Click the Notes icon  to display the notes that 
were added to the alarm. Clicking the Notes icon takes 
you to the Alarm Notes tab described below. For more 
information on notes, see “Alarm Notes” on page 70.

Select To 
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Alarm Notes
Alarm notes provide you with a handy way to record information about an alarm for all 
other users to view. For example, if you are managing alarms during an installation of 
vFoglight and if an urgent alarm comes up, you can add a note to the alarm that you are 
checking if the back-up process may be causing the problem. The note, along with a 
username stamp and a timestamp, are attached to the alarm.

There are two ways you can add notes from the Alarm Details dialog box by using 
either the: 

• History tab. The Notes  icon in the Alarm History table is for maintaining 
notes attached to a particular alarm in the history table. Clicking the Notes 

icon, takes you to the Alarm Notes dialog box.

Notes tab Displays a list of all alarm notes added to the alarm. Alarm 
notes allow you to record information about an alarm for 
yourself and for others. For example, after acknowledging an 
alarm you can include a note and details as to the alarm. All 
users can view and create a note but only the author of the note 
can edit or delete an existing note. Notes can be added to any 
alarm at any time even after the alarm has cleared. Alarm 
notes display:
• Created Time (time when the note was created)
• Description of the note
• User who created the note
• An Edit icon to enable the creator of the note to change 

the note description.
For more information, see “Alarm Notes” on page 70.

Select To 



Working with Dashboards 71
Common Views
• Notes tab. In the Notes tab, new notes are automatically attached to the most 
recent alarm in the alarm history.

You can also search for a note by using the Find button or Advanced button. See 
“Filtering Notes” on page 73.

Creating an Alarm Note
Alarm notes consist of freeform non-localizable text, a user name and a timestamp.

To create an alarm note:

1 From the Alarm Details view you can either: 

• In the History tab, click on the Alarm note icon and then click Add. 
• In the Notes tab click New.

2 In the Add Note dialog box, type a description of the note.

3 Click Add.

The description is added to the Alarm Notes dialog box.

You also have the option to:
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• Acknowledge the current alarm. See “Acknowledging an Alarm” on page 63.
• Acknowledge Until Normal. Selecting this option acknowledges the current 

alarm and all consecutive alarms fired by the same rule on the same instance. 
This option is available to an outstanding (not-yet-cleared) alarm only. 

• Clear the selected alarm. See “Clearing an Alarm” on page 65.

Editing an Alarm Note
Only the creator of the note can edit the note.

To edit an alarm note:

1 From the Alarm Details view, you can either: 

• From the History tab click the Notes  icon. 
• From the Notes tab, go to step 2.

2 Click the Edit  icon.

3 In the Edit Note dialog, change the description of the note.

4 Click Submit.

The description of the note changes to the modified text.

Deleting an Alarm Note
Only the creator of the note can delete the note.

To delete an alarm note:

1 From the Alarm Details view you can either: 

• Click the History tab, and then click on the Alarm note icon. 
• Click the Notes tab.

2 In the Alarm Notes dialog box, select the checkbox of the note(s) you want to 
delete.

3 Click Delete.
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The selected notes are removed.

Filtering Notes
You can filter notes by clicking the Find button or the Advanced button in the Notes tab 
of the Alarm Details dialog box. Using the Regular Expressions option when filtering 
notes enables you to search substrings.

To filter a note using the Find button:

1 In the Alarm Details view, click the Notes tab for a particular alarm.

2 Click in the textbox and type a string. If desired, click the Regular Expressions 
checkbox to filter notes on substrings.

3 Click Find.

To filter a note using the Advanced button:

1 In the Alarm Details view, click the Notes tab for a particular alarm.

2 You can filter notes by using one or more of the following criteria:

• Created Time (range, earliest available, current date)
• Severity (Undefined, Normal, Fire, Warning, Critical, Fatal)
• Note. Click the Use Regex checkbox to select the Regular Expressions option 

to filter notes on substrings.
• User name. Click the Use Regex checkbox to select the Regular Expressions 

option to filter a user name on substrings.
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3 Click Find.

Host Summary
When a host summary or Host object is shown in the browser interface, you can view a 
host summary popup or dwell. 

Figure 14

A diagnostic time range is displayed at the top of the popup summary. This time range 
indicates the period during which the alarm was fired. It is usually in the past and is 
sometimes different from the time range that appears on a dashboard. For example, the 
following alarm occurred on Thursday October 23rd at a particular time range, while the 
date displayed on the dashboard is Friday October 24th. 
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Figure 15

Drilling down from here retains the time range during which the alarm occurred. To go 
back to the monitoring time range you last used, "unfreeze" the range by following the 
procedures in “Freezing a time range” on page 52.

Drilldowns
The following drilldowns are available from the Host Summary popup. 

Select To 

Health icon see links to:
• health of all alarm sources
• health of current alarm source
• all outstanding alarms for that alarm source 
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Creating a Custom Dashboard
In addition to using the dashboards that are supplied with vFoglight or created by 
dashboard developers in your organization, you can create custom dashboards for your 
specific needs. These dashboards can contain any combination of tables and charts that 
you find useful. You can use the Columns options in the action panel to choose the 
number of columns for the dashboard.

The custom dashboards that you create are located under My Dashboards in the 
navigation panel.

To create a dashboard:

1 Click Create Dashboard in the action panel.

The Create Dashboard dialog box opens.

Alarms see a list of alarms according to alarm severity. Click on a 
particular alarm severity to view:
• number of alarms for the particular severity
• the alarm error instance on a particular agent or host
• summary table of the time, instance, rule name and ack’d 

by details.

CPU, memory, 
disk, and network 

see a detailed drilldown of that part of the host’s performance.

Host Monitor 
Host Browser

see a real-time monitoring view of the host. 

Select To 
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2 Type a unique name for the dashboard in the Name field. This is the only 
information required to create a new dashboard. 

3 By default, a dashboard you create is not available to any vFoglight roles. You 
can select the default roles to control how people gain access to different parts of 
the browser interface. To do this, click the edit icon  beside Relevant Role(s) 
and/or Allowed Role(s) and select the appropriate roles.

• Relevant Role—Select the roles for allowing existing dashboard users to view 
a dashboard. The option to choose a relevant role is only valid for super users 
such as a Java administrator who also has an operator role. Selecting the 
Cartridge Developer role enables a filter to restrict certain user roles (e.g. 
Operator role) from accessing the dashboard. Selecting the Operator role 
allows anyone with this role to access the new dashboard. 

• Allowed Role—determines if a user role is allowed to see the dashboard. 
Selecting the Operator role allows anyone with this role to access the new 
dashboard.

4 If you want the views in your dashboard to be refreshed at regular intervals, click 
the Automatically refresh page every check box and choose one of the options. 
If you choose the second option, you need to enter a number of seconds in the text 
box to indicate the length of the refresh interval.

5 You can enter a description of the dashboard in the Context Help text box. This 
text will appear in a tooltip when you hover over the dashboard name in the 
navigation panel.

6 Click OK to save your dashboard. 

Two additional tabs (Views and Data) appear at the top of the action panel.

7 In the action panel, select the Views or Data tab and locate the views or portlets 
that you want to add to your dashboard. You can add both types of information to 
the same dashboard. For information on editing charts, see “Metrics Chart Editor” 
on page 83.
Note When you have finished adding views to your dashboard, you do not need to save it. 

It is automatically available under My Dashboards in the navigation panel.

8 To divide the display area into one, two, or three columns, choose the number of 
columns in the action panel, under the General tab > Columns. 
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Deleting a Custom Dashboard
You can delete any custom dashboard that you have created. You may also be able to 
delete dashboards created by other users, although this is not recommended. You cannot 
delete any default dashboards or dashboards created by dashboard developers in your 
organization.

To delete a custom dashboard:

1 Select the dashboard that you want to delete from the list under My Dashboards.

2 Click Delete this page in the action panel.

A confirmation dialog appears.

3 Click Delete to confirm the deletion.

The dashboard is removed from the My Dashboards view. 

Working with Charts
Data charting enables you to create pre-defined and customizable charts that let you 
access and analyze collected data.

This section describes the options available when you are adding charts to a dashboard 
or report that you have created.

Creating a Metrics Chart
To create a metrics chart:

1 Drag each metric from the Data tab in the action panel into its own chart, as 
shown below.
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Figure 16

2 You can also add one or more metrics to an existing chart.

Figure 17

• The metrics in the chart are indicated by different-colored lines at the left side 
of the chart under count and percentage (%). 

• The line for the currently displayed metric (by default, the first one chosen) is 
bold. To highlight other metrics in the chart, click on the lines in the legend. 
The legend below the chart changes to indicate the name of the highlighted 
metric. 

• When you hover over a line in the chart, a dwell indicates the name of the 
metric, as well as the count or percentage and the specific date and time when 
it was collected.



80 vFoglight
User Guide
The Y axis shows the units for the metric. If there is more than one metric in the chart, 
the Y axis shows the units for the first metric that was charted, unless you have 
unchecked the Layout check box in the Metric Chart Default dialog (see “Setting Metric 
Chart Labels” on page 88 for details). 

By using the Customizer function you have the option to export metric data for charts to 
CSV format. See “Exporting Data from Charts and Tables” on page 57.

Zooming Into Charts
For plot or bar charts, you can zoom into an area to view data at different levels of detail 
by using CTRL + drag. You can also drag on an axis to specify the region you would 
like to zoom into (a zoom region).

To zoom into a chart:

1 In a line graph, zoom in to the area of the chart. Select one of the following 
methods to specify a zoom region:

• press CTRL + drag on the area
• drag on the axes of the chart
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2 The chart will zoom into the range selected and will locally change the time range 
so vFoglight displays all data points. Now you can view the data for the selected 
metric at a more granular level. 

3 To zoom out and return the line chart to its original view, click the Reset Zoom 
icon  in the top right corner.

Changing the Chart Type
If the Customizer icon  is enabled for charts, you have the option to dynamically 
change the chart to a different chart type (bar, plot, area, stacking area). For example, 
choose the chart type to Area to emphasize the magnitude of change over time and 
illustrate the metric parts in relation to the whole graph.

Note To access the customizer it needs to be enabled. By default, chart customizers are not 
enabled.

To change the chart type:

1 Click the Customizer icon  in the top right hand corner of the chart.

2 In the Chart Type dialog box, click the chart type to change. 

The chart dynamically changes to the selected chart type.
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To export the chart to CSV or PDF format, see Exporting Data from Charts and Tables.

Chart Options
You can edit, save, maximize, restore, or close a chart by clicking the icons in the title 
bar. The editing options are described under “Metrics Chart Editor” on page 83.

Note All other charts are hidden when you maximize a chart.

To save a chart:

1 Click the save icon  in the title bar of the chart that you want to save.

The Save Individual View dialog box appears.

You can accept the default name, edit, or type another name for the chart.

2 Select the format in which you want to save the chart. 

• Portlet—this option appears in the Views tab when creating a dashboard. If 
you choose Portlet, the view will be available on the Views tab (under My 
Views) to be added to a dashboard that you create from the action panel. 

• Pagelet—this option appears as a view that is designed to be added to a page 
or dashboard.

• Reportlet—the main purpose of reportlets is to appear in the Views tab when 
creating a report. If you choose Reportlet, the view will be available on the 
Views tab (under My Views) from where it can be added to a report that you 
create from the action panel.
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Pagelets and Reportlets are listed under Configuration > Definitions in the 
navigation panel. If you have access to the Definitions area, you can use them 
when building a dashboard. For information about building dashboards, see the 
Web Component Tutorial.

3 Click OK.

Metrics Chart Editor
There are two editors that control how metrics are displayed in charts: one controls the 
settings for all the charts that you create; the other controls the settings for the current 
chart.

Editing a Chart
To edit a chart:

1 To apply changes to any new metrics chart that you created, click Set metric 
chart defaults in the action panel. The Metric Chart Defaults dialog opens.

Figure 18

2 Click the edit icon  in the title bar of a chart to display an edit dialog where you 
can make changes that affect only that chart.
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Figure 19

The settings you can change are described in the following table. Note that not all the 
options are available in both dialogs.

Setting Description Options/Limits

Title Allows you to rename the chart. No specific limits, but keep 
display space in mind.

Metric Label Allows you to choose another 
label for the metric.

Only available when 
editing a single chart.

Parent Label Allows you to choose another 
label for the parent metric. This 
label appears in the title of a 
chart that contains metrics from 
a single parent. 
The parent label appears in the 
legend when the chart contains 
metrics from more than one 
parent. (For example, see 
“Grouping Metrics with Many 
Parent Hosts” on page 87.)

Only available when 
editing a single chart.
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Chart Lists the available types of 
chart.

• Plot (default)
• Area
• Stacking area
• Bar

Height Sets the height for all charts or 
this chart.

The default chart height is 
300 pixels.

Layout Select “Only show metric of 
selected chart” to show only 
one axis is used in the chart, 
regardless of how many metrics 
are displayed. (For examples, 
see “Setting Metric Chart 
Labels” on page 88.)
Clear the check box to display 
the label for all metrics in the 
legend.

Check box. 

Line Thickness Specifies the thickness of lines 
in all charts or this chart.

• Automatic
• Small
• Medium
• Large

Setting Description Options/Limits



86 vFoglight
User Guide
Metric Value Controls the type of value that 
is displayed for one metric or 
all metrics in a chart.

• None
• Average: The chart 

displays the average 
value for the metric per 
interval.

• Minimum: The chart 
displays the actual 
lowest value for the 
metric per interval. 

• Maximum: The chart 
displays the actual 
highest value for the 
metric per interval.

• Minimum/Maximum: 
The chart displays the 
maximum and 
minimum value for the 
metric per interval.

• Sum

Show data at 
both start and end 
of intervals

Applies only to plot and area 
charts.

Check box

Show Overall Displays the overall value for 
the set time range as a dashed 
line.

• Average displays the 
overall average.

• Min displays the 
overall minimum. 

• Max displays the 
overall maximum.

Show Min/Max 
As

Displays the minimum and 
maximum per interval.

• Envelope (a filled-in 
area between the 
minimum and 
maximum)

• Marks
• Lines

Setting Description Options/Limits
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Grouping Metrics with Many Parent Hosts
When you have many metrics on a chart from different parent hosts, the parent label 
will appear in the legend when metrics are grouped. For example, in the chart on the left 
below, if you drag metrics from a Windows_Host and from a Windows_CPU, the parent 
label shows up in the metric labels themselves since the metrics are mixed. In the chart 
on the right below, if you drag metrics from the Windows_CPU host only, the legend 
does not refer to the parent.

Show Baseline 
Min/Max As

Displays the baseline minimum 
and maximum.

• Envelope (a filled-in 
area between the 
minimum and 
maximum)

• Marks
• Lines

Show Standard 
Deviation As

Similar to the Min/Max setting; 
lets you highlight a range per 
interval. You determine the high 
and low values by setting the 
deviation from the average.

The default value is 1, but 
the unit of deviation 
depends on the metric.
• Envelope (a filled-in 

area between the 
minimum and 
maximum)

• Marks
• Lines

Show Thresholds If a metric has a threshold, it is 
displayed.

You can choose to show 
thresholds only for the 
selected metric. 

Setting Description Options/Limits
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Figure 20

Setting Metric Chart Labels 
The Layout option enables you to choose the layout of the metric chart axes. 

Figure 21

• Select the Layout check box for a chart to indicate only one axis is used in the 
chart, regardless of how many metrics are displayed, as shown below.
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Figure 22

• Clear the Layout check box to display all the axes in the chart, as shown below.

Figure 23

Viewing Dashboard Properties
When you are viewing a dashboard, you can edit some or all of its properties and 
definition if you have the appropriate role(s).

You can also use this procedure to publish a dashboard that you have created. 

To view the properties of a dashboard:

1 Select the dashboard whose properties you want to view or change.

2 Click Properties in the action panel. 

A popup appears.
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3 Click Edit basic Properties.

The Edit View Properties dialog appears.

Depending on your role(s), you may be able to change some or all of the 
properties. 

To make available a dashboard that you have created, it is recommended that you 
choose Operator for both the Relevant Role and Allowed Role. 

4 Click OK to close the dialog and save any changes.

If you have access to the Definitions area (under Configuration in the navigation panel), 
you can view (and possibly make changes) to the definition of a dashboard. For details 
about creating dashboards, see the Web Component Tutorial and the Web Component 
Guide.

To view or change the definition of a dashboard:

1 Select the dashboard whose definition you want to view or change.

2 Click Properties in the action panel. 

3 Click Go to full definition in the popup.

The definition page for this dashboard appears.

4 If you can make changes to the definition, click Edit.

5 If you have made changes to the definition, click Save.
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Working With Tables
You can sort and filter data in a table, if these functions are enabled on the table.

Sorting Tables
If a table is sortable, you can sort it by clicking the column-header text. A down ( ) or 
up ( ) icon in the table header indicates the current sort order.

Filtering Tables
Some tables have a filter option in the title bar. When you click it, a dialog opens in 
which you select filtering criteria. You then click Apply to refresh the table and display 
only those rows in which the data meets the specified criteria. For an example of table 
filtering, see “Filtering the Alarms View” on page 62.

Hiding Columns
Another way you can filter tables is to hide some of the columns. If this option is 
available, there is an edit icon ( ) at the top of the table. Clicking the edit icon opens a 
popup list of all the columns, where you can de-select the columns you want to hide and 
click Apply. To display a hidden column, select it and click Apply. For an example, see 
“Hiding Columns in the Alarms View” on page 63.

Paging Icons
By default, most tables display only a set number of rows. If there are more rows, you 
can display the additional rows by using the paging buttons:

Note Active buttons are blue. Disabled buttons are gray.

Button Name

First page

Previous page

Next page

Last page
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Printing Views
You can print vFoglight views using the Print option in the actions panel. The view is 
displayed in a separate browser with a standard print dialog.

Note To generate a PDF file for a table that exceeds the number of rows to fit on a single page, 
the table should be specified as either a top level view with the Purpose = report in 
Configuration > Definitions, or it should be included in the Report Layout container.

The output is formatted using the Print theme specified in the User Preferences page. 
(see “User Preferences” on page 36 for details). You can override this setting by 
choosing a different option in the action panel under Themes.
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Working with Services and Alarms

A service is a collection of objects that you want to monitor. Some services are created 
automatically (such as Hosts and Databases) as part of the vFoglight Management 
Server or as part of the cartridges you deployed. However, most services are created by 
users based on what they find interesting, and are typically organized around what a 
user needs to monitor. Different groups of users can define their own services. For 
example, a database administrator creates database services or a vFoglight administrator 
creates System services.

Alarms are triggered by performance problems on services. This chapter provides 
details on how to view system-wide alarms for all monitored services. 

This chapter contains the following sections:

Overview......................................................................................................................................94
Monitoring Services .....................................................................................................................96
Viewing System-Wide Alarms and Service Details ...................................................................104
Examining Details on a Single Service......................................................................................105
Viewing Service Levels..............................................................................................................106
Building a Service......................................................................................................................108
Filtering Alarms.......................................................................................................................... 115
Monitoring System-Wide Alarms ............................................................................................... 118
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Overview
In vFoglight, a service is defined as a grouping of one or more monitored components. 
Typical examples of monitored components include a host, a database, a VirtualCenter 
server, etc.

Services can be nested within other services, each with their own monitored 
components. All vFoglight services are listed on the Services dashboard, which can be 
accessed from the navigation panel. From here you can perform the following tasks:

• Monitoring Services

• Viewing System-Wide Alarms and Service Details

• Examining Details on a Single Service

• Viewing Service Levels

• Building a Service

• Filtering Alarms

• Monitoring System-Wide Alarms

Icons
There are several different types of icons used to represent monitoring data in vFoglight. 
The types are:

• Severity Icons

• State Icons

• Availability Icons

The severity and state icons tell you about the condition of an application, server, or 
process. They are based on the values stored in the metrics. What they represent 
changes according to their context. For example, the same state icon can indicate that a 
server is down or that a process is down.

Many summary views show icons that represent an aggregation of the detailed objects 
of similar types. vFoglight prioritizes the data when determining the aggregation. For 
example, if three test servers are down, and one production server is active, then a 
summary view would show a critical icon, not a fatal icon.

Depending on where it is, you can hover over a severity or state icon or click it to get 
further information about the condition it represents.
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Severity Icons
Severity icons indicate the severity level of alarms that have fired.

The normal icon indicates that there have been no critical, warning, or fatal events fired. 
vFoglight does not record events that are successful; it can only determine that there are 
no events that had problems.

State Icons
State icons indicate the status of a domain, server, application, or process. 

Icon Description

Normal

Warning

Critical

Fatal

Icon Description

Normal

Warning

Critical

Fatal
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Availability Icons
Availability icons indicate the availability of an application, service, or process.

Monitoring Services
You can monitor services using the Services dashboard. This dashboard shows the state 
of a selected set of services. From this dashboard you can see the alarms for all selected 
services, alarms for a specific service, the SLA state for a service, and the contents of a 
service. You can also navigate to dashboards where you can change service definitions. 
This dashboard is the best one to use for monitoring services.

To start monitoring services:

1 On the navigation panel under Dashboards, click Services > Services. 

Tip The Services dashboard is one of the default home pages so you can also click Services 
under the Homes section in the left hand pane for quick access.

The Services dashboard appears. 

Icon Description

Available

Not available
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Monitoring Services
Figure 1

Figure 2

This dashboard contains two views:

• Categories and Services

• Outstanding Alarms for Selected Categories 

Categories and Services
The Categories and Services view lists all the monitored services by category. For each 
category and service it displays the following information for the current time range.

Select To display

A category or service the view that is described in “Viewing Details about 
a Service” on page 99.
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Filtering the Categories and Services List

You can filter the list of service categories that are displayed in the Categories and 
Services view. 

To filter the Categories and Services list:

1 In the Action panel, click Category Selector. 

The Category Selector dialog box displays all the available services.

2 Select the service or services that you want to display, or de-select the service or 
services that you do not want to display. 

You can click Show All to select all the services or click Clear to de-select all the 
services.
Note If you click Clear, you must then select at least one service before you can proceed.

3 Click the Close button  to close the dialog box. 

A Service Level Compliance 
icon

further details about the related Service Level 
Agreement. 
A service can have one or more service level 
policies. The compliance icon of a given service 
shows the worst state of all the service level 
policies that are defined for the service. 
For example, in the above screen, the Windows 
service has a Fatal SLA state because one of its 
components has a Fatal state, even though the 
others are in a Critical state.

An alarm icon a list of alarms for components that are being 
monitored. This is a common view in vFoglight. 
For further information, refer to “Alarm List” on 
page 58.

Select To display



Working with Services and Alarms 99
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The Categories and Services view displays only the services that you selected.

Viewing Details about a Service

The Categories and Services view provides a number of ways to see more detailed 
information.

• From the Services and Category list, select a category or service to see details by 
service and host. The popup also provides links to more detailed views, which are 
described in the table below.

Click this link If you are interested in seeing..

Service Breakdown the structure of a specific service. For details, see 
“Drilling Down to Detail Views” on page 100.

Service Details detailed information about a service. For further 
information, see “Examining Details on a Single 
Service” on page 105.

Impact List a list of services impacted by the current service.

Service Level Agreement(s) detailed information about the service level 
agreement(s) defined for a service. For more 
information, see “Viewing Service Levels” on 
page 106.
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If you hover over a category, you see the same popup without the links.

Drilling Down to Detail Views
Clicking the Service Breakdown link in the popup shown on page 99 takes you to the 
Service Breakdown view for that service. 

Figure 3

This view provides details about how a specific service is comprised. From here, you 
can drill down to more specific details, as outlined in the table below. 

Scan for a Root Cause a diagram that shows the composition of a service 
and the state of each component in the service. It 
allows a user to quickly scan for the root cause of a 
problem reported on the service. For details, see 
“Root Cause Analyzer” on page 102.

Service Builder the Service Builder for the selected service or all 
monitored services. For details, see “Building a 
Service” on page 108.

Select To display

A component a popup that provides a summary of the host, 
service, or application. This summary includes the 
number of alarms by severity, health status, and 
related links. 
For a description of the host summary popup, refer 
to “Host Summary” on page 74.

Click this link If you are interested in seeing..
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For example, if you click an icon in the Service Level Compliance column, you will see 
a popup like the one in the following screen shot.

Figure 4

Notice that this view contains links to the Service Level Agreements for this service. 
For details about this dashboard, see “Viewing Service Levels” on page 106.

The Service Breakdown view also summarizes the service’s contents from a number of 
different perspectives, namely by Monitored Component(s) and Related Host(s). Refer 
to the table below for details. 

A Service Level Compliance 
icon

further details about the related Service Level 
Agreement. 
The Service Level Compliance for a category or 
service is determined by the component in the worst 
state. 

A health icon links to:
• health of all alarm sources
• health of current alarm source
• all outstanding alarms for that alarm source 

An alarm icon a list of alarms for components that are being 
monitored. This is a common view in vFoglight. 
For further information, refer to “Alarm List” on 
page 58.

Select To display



102 vFoglight  
User Guide 
Root Cause Analyzer
Clicking the Scan For A Root Cause link in the popup shown on page 100 allows you 
to manually change the vFoglight-created /default, topology layout of the hosts and drill 
down to a diagram of the components to which this one is connected. Each component 
has a state icon, which helps you trace the critical path of performance issues across a 
domain. (For an explanation of the icons, see “Icons” on page 94.)

As shown below, the path to a child in a Fatal state is red, while the path to a child in a 
Normal state is green. The path to a child in a Warning state would be yellow.

Click this link To display

Monitored Component(s) a list of the components that are being monitored by 
a specific service. 
To quickly find a component, enter the component 
name in the search text box at the bottom of the 
dashboard. For example, enter CPU in the text box 
to find all CPU components in the service. 

Related Host(s) a list of hosts that are being monitored by a specific 
service. 
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Figure 5

You can move the depth control in the upper right corner back and forth to set the 
number of levels (1-6) in the diagram. The default setting is three levels.

The dots above the depth control determine the scale of the diagram.

• Click the smaller dot to reduce the scale for easier navigation of large diagrams.

• Click the medium dot to restore the diagram to its original scale.

• Click the largest dot to zoom to the highest zoom level. 

Auto Arrange is selected by default. If you move a component, the Auto Arrange check 
box is deselected. From here you can manually layout the components as you wish. To 
return to the original layout, select the Auto Arrange check box. 

Outstanding Alarms for Selected Categories
The Outstanding Alarms for Selected Categories view contains a table that lists the most 
recent alarms for the category selected in the Categories and Services view.
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Figure 6

You can filter the list in the Outstanding Alarms view using several criteria. For details, 
see “Filtering the Alarms View” on page 62.

Viewing System-Wide Alarms and Service Details
The Services (All Alarms) dashboard is a summary dashboard that contains views with 
information from other dashboards such as service levels, alarms, and system changes.

To view system-wide alarms and service details:

• From the navigation panel under Dashboards, click Services > Services (All 
Alarms). 

The Services (All Alarms) dashboard appears.
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Examining Details on a Single Service
Figure 7

The Categories and Services view is described under “Categories and Services” on 
page 97.

The All System Alarms and Changes and Outstanding Alarm(s) for the Entire System 
views are described under “Monitoring System-Wide Alarms” on page 118.

Examining Details on a Single Service
The Service Details dashboard contains views that provide detailed information about a 
service. It shows all the SLAs, the service impacts, a full definition viewer, monitored 
components, host perspectives, and an alarm list for the selected service.

This is the best dashboard to use to view a service in detail. 

To examine details on a single service:

• From the navigation panel, under Dashboards, click Services > Service Details. 

The Service Details dashboard appears.

Note You can access this dashboard from the Services dashboard by selecting a service and 
choosing Service Details in the popup.
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Figure 8

To see data for another service, select Service Selector in the action panel to open the 
Service Selector dialog, where you can choose another service. 

To choose another service:

1 From the action panel, select Service Selector. 

The Service Selector popup appears. 

2 Navigate to the service for which you want to see details. 

The Service Details dashboard is refreshed with data about the chosen service. 

3 Click  to close the popup. 

Viewing Service Levels
The Service Levels dashboard provides details about the service levels that are being 
monitored by vFoglight. Use this dashboard to measure the availability of a service.
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Viewing Service Levels
To examine service levels:

1 From the navigation panel, under Dashboards, click Services > Service Levels. 

The Service Levels dashboard appears.

This dashboard lists the current status, recent availability (used to determine the status), 
and health history. 

Other information that is displayed is listed under the following headings.

Service Level Agreement Information
The Service Level Agreement Information area includes the description, the monitored 
source, and the availability criteria that are used to determine the status of the SLA. 

Availability Graphs
The availability graphs display data for the service level alarms. The three areas display 
data for the current time period, week, and month. The tables to the right of each graph 
summarize the severity level, source, and message for each alarm. Clicking an alarm in 
a table displays a popup with details about that alarm. 
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Choosing Another Service Level
To see service levels for another service, select Service Level Selector in the action 
panel.

To choose another service level:

1 From the action panel, select Service Level Selector. 

The Service Level Selector popup appears. 

By default, the Service Level Agreements for all the monitored services are listed.

2 Select the Service Level Agreement for which you want to view details. 

3 If you do not want to see the list of all the Service Level Agreements, deselect the 
List All Service Level Agreements check box. 

The Service Levels dashboard is refreshed with data about the chosen service.

Building a Service
A service is a grouping of one or more components. The Service Builder provides the 
functions needed to create a new service, tier, application, or category as well as edit 
existing services. When you create a service, a corresponding service level is 
automatically created.

To navigate to the Service Builder:

1 From the navigation panel, under Dashboards, click Services > Service Builder. 

The Service Builder dashboard appears.

Services are used as inputs on many other dashboards (Hosts Table, Agents) besides the 
Services dashboards, as well as in reports. Defining a good set of services can make 
other dashboards more useful and easier to understand. 
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Creating a New Category
Use the Service Builder dashboard to create categories that will be used as inputs on 
many other dashboards. 

To create a new category:

1 In the Service Builder dashboard, click Add  and then select Add Category.

The New Category dialog appears.

2 Type a name for the category. 
Note You can change the name of a service at a later date, without losing all history for a 

service. See “Editing a Service Name” on page 114.

3 You can enter text in the Short Description and Description fields, but these are 
optional. The text in the Description field appears in a popup when you hover 
over a service. You can modify the description later by following the procedures 
described in “Editing a Service Description” on page 115. 

4 Click Create.

The new category is added to the list.

Creating a New Application
Applications that you create here will be added as a service in the Applications category. 

To create a new application:

1 In the Service Builder dashboard, click Add  and then select Add 
Application.

The Application Creator dialog appears.
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2 Type a name that is unique to vFoglight for the application and click Create.

The new application is added as a service to the Applications service category. An 
application topology component is added below the service. For example in the 
screen shot below, test app has been added as a service to the Application service 
category. A corresponding application topology component has been added below 
the new application. 

From here you can add application tiers to the new ApplicationTopology component. 
Refer to “Adding an Application Tier” on page 113 for details. 

Building a Service
Use the Service Builder dashboard to build a service or category as well as add a service 
to vFoglight. 

To build a service:

1 Click Add  for the service or category with which you want to work. 

2 From the popup, select Add Components. 

The Add to: dialog appears. From here you can choose the components that you 
want to add as well as create a new service.

3 Select the type of component that you want to add by navigating through the 
Services, Hosts, Foglight4Model, Applications, All Models, and Dynamic 
Managed Components tabs. 
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Use Find, Clear, and Advanced to locate a component. Select All and Unselect 
All quickly chooses the listed components that you want to add. To locate a 
component by name and type, click Advanced. You can also use regular 
expressions. 

4 When you have chosen the components, click Add.

5 To add a new service, click New Service, and then enter a name and description 
for the service.

The service is added to the component that you chose in step 1. 

Adding Dynamic Managed Components
Using the Service Builder dashboard, you can dynamically manage components by 
specifying a rule for adding objects to a service so that the default service is created or 
updated when certain data arrives. Therefore, if a component is added or removed, the 
default service is automatically updated to handle addition or removal of the component 
from the service. 

For example, if you are monitoring an application that runs four WebLogic servers, you 
can create a service and specify a rule to add WebLogic server instances for a particular 
domain so that the service is updated when more servers are added or deleted. After 
adding the rule, you can see that the new WebLogic servers appear automatically in the 
service after four more WebLogic servers were added. Likewise, if the original four 
WebLogic instances running on Windows are decommissioned, they automatically 
disappear from the service.
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In another example, if you create a service called “FX” on the infrastructure that 
monitors a webservice, you can create a rule to include another infrastructure that is 
used for extra capacity during peak times. When the other infrastructure for high 
capacity is used, it shows up in the service.

To add a dynamic managed component:

1 From the navigation panel, under Dashboards, click Services > Service Builder.

2 Drill-down to the appropriate service or category and click Add  in the 
Actions column.

3 In the Add to: dialog, click the Dynamic Managed Components tab.

4 Type a Name for the query.

5 Select a root node for the query. For example, click Hosts > All Hosts.

6 In the Filter box, type a query such as: 
name like '%.prod.quest.corp'

7 Click Test and confirm that it comes up with one entry for the query result.

8 Click Add. At this point you should see a new dynamic managed component 
appear under the service that is associated with one host.
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Adding an Application Tier 
When you create an application using Application Builder or Service Builder, you 
specify the application tier that you want to use. In the Service Builder dashboard you 
can also do this when you build an application. 

To add an application tier:

1 Click Add  for the application topology component for which you want to add 
a tier. 

The Applications Tier dialog box appears. 

2 From here you can create a new application tier or select from a list of application 
tiers that are already in use by other monitored applications. 

3 From the Application Tiers list, click Add  beside the tiers you want to add to 
the selected application

or

If you want to create a new tier, click .

The Tier Creator dialog box appears.

4 Select the type of tier you want to create from the drop-down list.
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5 Type a name for the tier and click Create.

The name of the new tier is added to the Application Tiers list.

6 Use Find, Clear, and Advanced to locate an application tier. To locate a tier by 
name and type, click Advanced. You can also use regular expressions. 

7 Continue to add tiers to the application. 

After you have added all tiers, you can then add other components to the tier by 
following the steps outlined in “Building a Service” on page 110.

Removing a Service, Category, Monitored Component, or Tier
You can remove a service, category, tier, or a monitored component from its related 
service. 

To remove a service, category, monitored component, or tier:

1 Click Remove  for the service, category, tier, or monitored component that 
you want to remove. 

From the popup, choose whether you want to remove either the selected item, or 
the monitored components in the selected item. 
Note Depending on the component that you select, you may not receive a popup but 

instead are prompted to confirm the deletion. Click Confirm to remove the item.

2 If you want to remove monitored components, you are prompted to select the 
components that you want to remove. Use Select All and Unselect All to quickly 
choose the components. 

3 After you have selected the components, click Remove. 

You are prompted to confirm the deletion. 

4 Click Confirm to continue. 

Editing a Service Name
By clicking the Edit button on the Service Builder dashboard and Services dashboard, 
you can rename an existing service without having to delete and recreate the service. 
This means that all history for a service is retained, such as the performance of the 
systems to suit your needs. For example, if you create 50 services but then you need to 
change the name of the service due to a spelling error you can change the service name 
without losing service data information. 
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To edit a service name:

1 On the Service Builder dashboard, click Edit  for the service name you want 
to change.

The Edit Service Descriptions dialog box appears.

2 Change the name and click Update. The service name is changed but the service 
state is not altered.

Editing a Service Description
You can change the service description that is displayed when you hover over a service 
that is listed on a dashboard.

To edit a service description:

1 Click Edit  for the service you want to edit. 

The Edit Service Descriptions dialog box appears.

2 Modify the descriptions and then click Update. 

Filtering Alarms
Alarm filters can be defined for any service or application tier instance in the Service 
Builder. You can use alarm filters to specify alarms that are relevant to a given service 
as a way to keep an irrelevant alarm from falsely causing a service outage, rather than 
have all alarms impact the state of a service. 

For example, alarm filtering can be used to ignore a certain state for a component with a 
high CPU usage. vFoglight is monitoring an application that runs on a Weblogic server 
and you create a service called "Retail" that includes the server and the host. The 
"Retail" service is shown as being unavailable when the host has a CPU usage greater 
than 90%. However, generally this is not considered a true service outage for this 
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service. If you look at the host alarms none of the alarms apply to the Retail service. As 
a result, you can use an alarm filter to filter out all host rules.

In another example, you can use an alarm filter to ignore the state of a service that 
appears as unavailable when the file system component for the D: drive fills up. 
vFoglight is monitoring an application that uses a host for the Siebel database and you 
want to filter out the Oracle database. The database is configured so that it uses only the 
C: drive, not the D: drive. A service was created to monitor the application that includes 
the Oracle agent and the host instance for the Oracle host. However, the service shows 
as unavailable if the D: drive fills up. Since the D: drive does not contribute to the 
availability of the application, you should add an alarm filter to exclude the monitoring 
of the D: drive. You can restrict the filter by choosing the FileSystem alarm, then 
specifying a Groovy script to refine the filter to apply only to the D: drive.

Adding an Alarm Filter
By specifying an alarm filter, you can decide what alarms impact the availability of a 
service.

To add an alarm filter:

1 From the navigation panel, under Dashboards, click Services > Service Builder.

2 Drill-down to the component and click the Alarm Filters  button.

The Alarm Filters dialog shows alarms inherited from parents of the current 
service.

Note Alarm filters can be defined for two nested services. Alarm filters work the same way 
regardless they are nested or not. Even though a set of alarms is not filtered out by 
the alarms’ immediate parents, the set of alarms are eventually filtered out by an 
alarm filter defined for one of the alarms’ parents further up the hierarchy of nested 
services.

3 You can select an existing filter from the list or click  to add a new filter.

The Add Alarm Filter dialog appears.
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4 Select one or more filtering options:

• By Rule—select the By Rule check box and choose a rule to monitor one or 
more of the nested children added to the service. You can define more than one 
alarm filter for the same rule. 

• Alarms—select the state of alarms to include or exclude:

- Include: all alarms are excluded except those specified in the include filters. 
- Exclude: all alarms are included except those specified in the exclude filters. 
- If both Include and Exclude filters are defined: include alarms that are 
specified in the Include filters as long as they are not excluded by the Exclude 
filters. 

• Groovy Script—an optional script used to refine the filtering. An alarm is the 
only required input, meaning you can filter on anything that is referenced by 
the alarm. An example of a groovy script is: 
@alarm.get('topologyObject').getType().getName() == 
'Windows_System_System_Table'

5 Click Save.

The filter is saved on the Alarm Filters list.
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Figure 9

Deleting an Alarm Filter
To delete an alarm filter:

1 Drill down to the component from the Service Builder dashboard and click the 

Alarm Filters  button.

2 In the Alarm Filters dialog, select the filter and click .

Example: Filter fatal alarms fired by the Processor Utilization rule
For example, to include only alarms fired on Processor 0 by the CPU_Utilization rule, 
you select the following parameters in the Alarm Filters dialog box:

• By rule: CPU_Utilization

• Alarms: Include All

• Groovy script: @alarm.get('topologyObject').get('longName') == 
'Processor_Table 0')

Monitoring System-Wide Alarms
Unlike the alarms displayed on the Services dashboard which show only those alarms 
for a selected service, the Alarms dashboard is useful for viewing the state of all alarms 
across the entire vFoglight installation and allows you to take immediate action on 
them. It also shows the alarm count by time, so that alarm storms or outage events can 
be identified.

To monitor system-wide alarms:

• From the navigation panel, under Dashboards, select Alarms > Alarms. 

The Alarms dashboard appears. 
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The Alarms dashboard has two views that display data for the time range indicated at 
the top right of the dashboard. For information about changing the time range, see 
“Time Range” on page 51.

• All System Alarms and Changes

• Outstanding Alarm(s) for the Entire System

All System Alarms and Changes 

This view contains charts that summarize the alarm and change activity for the current 
time range. Hovering over a line or bar in a chart produces a tooltip with details about 
the alarm or change that occurred nearest to that time.

Outstanding Alarm(s) for the Entire System

This common view lists in a table all the alarms for the current time range, except SLA 
alarms. The current time range can be fixed as described in “Freezing a time range” on 
page 52.

The totals for each level of alarm, and the total number of alarms in the table, are in the 
upper left corner of the view. You can filter the list, sort it by column, and acknowledge 
and clear alarms in this view. 
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You can see more detailed information about an alarm by hovering over or clicking a 
column to display a dwell or a popup. The content of the dwells and popups varies 
according to the column you choose.

For information on working with the different alarm views, refer to “Alarm List” on 
page 58. 
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Monitoring Agents and Hosts

This section describes how to view monitor agents and hosts. Several dashboards are 
available in vFoglight to help you with this activity.

This chapter contains the following sections:

Overview....................................................................................................................................122
Viewing Agents..........................................................................................................................122
Viewing Host Performance ........................................................................................................124
Viewing Host Details..................................................................................................................128
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Overview
Agent and host dashboards are monitored by Operators (for example, Unix System 
Operators) whose primary responsibility is availability of those hosts. From these 
dashboards you can perform the following tasks:

• Viewing Agents

• Viewing Host Performance

• Viewing Host Details

Viewing Agents
The Agents dashboard lists the agents that are available for each host. It is useful for 
monitoring from the perspective of hosts and agents. If you want to look at agents and 
the hosts where they are running, you will find this the most helpful dashboard. 

To get started monitoring agents:

• From the navigation panel, under Dashboards, click vFoglight > Agents. 

The Agents on All Hosts dashboard appears. 
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Viewing Agents
The Monitored Hosts and Agents and the Outstanding Alarms views are displayed. 
Drilldowns for each of the columns on this dashboard are explained below. 

Drilldowns for the Agents on All Hosts View

Tip Hovering over a column displays a dwell with more detailed information. 

Select To display

Agent or a host a popup that provides a summary of the host, 
service, or application. This summary includes the 
number of alarms by severity, health status, and 
related links. 
This is a common view in vFoglight. For a 
description of the host summary popup, refer to 
“Host Summary” on page 74.

Health icon links to:
• health of all alarm sources
• health of current alarm source
• all outstanding alarms for that alarm source 

Alarm icon a list of alarms for components that are being 
monitored. This is a common view in vFoglight. 
For further information, refer to “Alarm List” on 
page 58.

Health History a popup that focuses on the state history of a host 
condition such as OK, warning, critical, or fatal.

State a popup that allows you to activate or deactivate 
the agent as well as start and stop data collection.

Health State alarms for the host or agent selected in the 
Monitored Hosts and Agents view. This is a 
common view in vFoglight. For further 
information, refer to “Alarm List” on page 58.
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You can filter the hosts by clicking Service Selector in the action panel to open the 
Service Selector dialog. For more information on working with the Service Selector, 
refer to “Examining Details on a Single Service” on page 105.

Figure 1

Viewing Host Performance
You can view the performance of:

• a single host

• all monitored hosts

• hosts in real-time

Viewing Performance of a Single Host 
The Host Resource dashboard provides a detailed full-page view of the performance of 
a single host. It contains charts and tables that provide details about CPU, memory, disk 
I/O, and network utilization.

This dashboard shows more current and historical information than the Host Monitor 
dashboard, which is more like a real-time monitor. 

To view the performance of a single host:

1 From the navigation panel, under Dashboards, click Hosts > Host Resource. 

The Host Resource dashboard appears.
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Figure 2

The name of the current host is at the top left of the dashboard. To see data for another 
host, click Host Selector in the action panel to open the Host Selector dialog, where you 
can choose another host.

Viewing Performance on All Monitored Hosts
The Hosts Table dashboard is the best high-level summary of host performance. It 
summarizes information on alarms and CPU, memory, disk, and network utilization for 
active hosts. This dashboard is useful for monitoring from a host perspective, especially 
where there is a large number of hosts.

To view the performance on all monitored hosts:

• From the navigation panel, under Dashboards, click Hosts > Hosts

The Hosts Table dashboard appears.
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Figure 3

You can remove one or more of the columns in the table by clicking the edit icon  at 
the right-hand end of the title bar to open a list of columns, where you can de-select the 
column(s) that you want to remove.

You can filter the list of hosts by clicking Host Filter in the action panel to open the 
Host Filter dialog. 

Figure 4

You can choose to display all hosts or only active hosts and filter the information from 
each host by service.

Viewing Real-Time Performance 
The Host Monitor dashboard provides a real-time overview of how a host is 
functioning. The name of the current host is at the top left of the dashboard. The state of 
the various components is indicated by colors (see “State Icons” on page 95 for details). 
Discs with stateless metrics are displayed in blue.

To view real-time performance of hosts:

1 From the navigation panel, under Dashboards, click Hosts > Host Monitor.

2 To select a host to view in the host monitor, select the host from the Host Selector 
menu at the bottom of the navigation panel on the left.
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Figure 5

Drilling Down to Detail Views
The dwells in this dashboard are mostly charts, such as the one in the Host Monitor 
dashboard. This dashboard also has a number of areas from which you can drill down to 
more detailed dashboards. 

For example, clicking the Processes button in the CPU view takes you to a dashboard 
that displays detailed information about CPU utilization and processes for the current 
host, as shown below. 

Figure 6

Hovering over a line or area in a chart displays a tooltip with data for the nearest time.
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You can view details on:

• a single host

• a host (in portlet format)

Viewing Details on a Single Host
The Host Browser dashboard is similar to the Agents browser, except that it shows the 
agents for only one host at a time. It contains two views: Agents Running on <host> and 
Outstanding Alarm(s) for <host>.

To view details on a single host:

• From the navigation panel, under Dashboards, click Hosts > Host Browser. 

The Host Browser dashboard appears.

The name of the current host is at the top left of the dashboard. To see data for another 
host, click Host Selector in the action panel to open the Host Selector dialog, where you 
can choose another host.
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The Outstanding Alarms view displayed at the bottom half of the dashboard is a 
common view in vFoglight. For further information, refer to “Alarm List” on page 58.

Viewing Host Details in Portlet Format 
The Active Hosts Summary dashboard displays information about each active host in a 
separate view. This dashboard is useful when you have a small number of hosts and 
want to see a visual summary of them. 

To view host details in portlet format:

1 From the navigation panel, under Dashboards, click Hosts > Active Hosts 
Summary.

The Active Hosts Summary dashboard appears.

Note A host becomes active when its memory usage is greater than 0%.

Figure 7

If you have a large number of hosts, you can use the Hosts Table dashboard, or use the 
Host Summary as a portlet in a custom dashboard and configure custom dashboards for 
each set of hosts.
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Monitoring the vFoglight 
Management Server

The vFoglight Management server is used to perform tasks such as host data sent from 
agents, run rules, and provides web-based UI access for monitoring servers. The 
vFoglight Management Server also contains various tools to monitor database schema 
and data objects and view diagnostic dashboards. 

This chapter contains the following sections:

Overview....................................................................................................................................132
Viewing Logs .............................................................................................................................132
Viewing Performance-related Dashboards................................................................................134
Inspecting Object Types ............................................................................................................141
Cleaning up Data Objects..........................................................................................................143
Selecting Metrics to Compare ...................................................................................................144
Viewing Server Metrics..............................................................................................................147
Looking at Server Details ..........................................................................................................149
Viewing MySQL Database Details.............................................................................................150
Viewing Persistence Handler Details.........................................................................................151
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Overview
The vFoglight module contains various tools to monitor schema and data objects as well 
as to monitor the vFoglight Management Server.

The vFoglight module contains the following dashboards and group of dashboards:

• Agents

• Diagnostic (Log Analyzer dashboard and Performance-related dashboards)

• Schema Browser

• Servers (vFoglight Management Server, MySQL database, Persistence Handler)

Viewing Logs
You can display multiple log files in vFoglight to view and analyze known events and 
error conditions such as verbose or informational type of messages. The Log Analyzer 
dashboard enables you to navigate, view, and download logs. The time, level, source, 
and description of log messages is displayed for logs you view in this dashboard. 

To view logs:

1 On the navigation panel under Dashboards, click vFoglight > Diagnostic > Log 
Analyzer > Overview.
Note You can also access the Log Analyzer dashboard through the Administration 

dashboard if you have access to the vFoglight Administration functions. On the 
navigation panel, under Dashboards, click Administration > Administration. In the 
Navigation view, under Tooling and Diagnostics, click Server Log Overview.

The vFoglight Log overview dashboard appears. 
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• To view the list of log messages in this dashboard, click . In the 
Log Selector dialog select the server.

• To download a log, select the appropriate log from the Log Overview dashboard 
and click  to open and view the log messages.
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Viewing Performance-related Dashboards
vFoglight includes a set of diagnostic dashboards which are useful for analyzing the 
performance of a vFoglight Management Server as well as diagnosing problems relating 
to the Management Server, agents, database, etc. 

The following performance-related dashboards are available:

• Overview Tab

Displays database activity, data service performance, JVM performance and 
server load on one dashboard.
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• Agents Tab

Displays a list of agents by type. This dashboard is useful for understanding the 
agents connected to the management server. Select the Plot feature to view the 
appropriate agent connectivity. 

To plot agent connectivity:

1 In the Plot tab, drill-down to the agent type. 

2 Select the check box for the agent that you want to plot. Alternatively, click 
Select All, to view all agent types.

3 Click Plot from the menu. 

The connectivity charts for the selected agent appears:
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• Connectivity Tab

Shows the vFoglight connectivity for the JDBC Connection Pool and the User 
Session count. 
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• Database Tab

Shows database activity such as data Input/Output, database buffer pool, and the 
number of inserts/deletes.

• Java Virtual Memory Tab

Contains information on Java Virtual Memory such as usage, initialization, 
committed, and maximized.
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• Topology and Agent Manager Tab

Shows the number of topology changes, skipped messages, and total messages. 
This dashboard is useful for understanding the topology structure relating to agent 
activity.

• Server Load Tab

Shows vFMS load metrics and JVM performance.
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• Rulette and Topology Tab

Shows the number of rulettes and the number of topology objects in the vFoglight 
Management Server. This dashboard is useful for understanding model 
complexity.

• Messages and Data Tab

Highlights whether data and metrics are being processed in time or getting 
discarded.
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• Derivation and Query Tab

Shows activity in the derivation and query service such as the number of 
evaluations, rulettes, errors, and cache performance.

Inspecting Object Types
Use the Schema Browser dashboard located in vFoglight > Schema to view 
information about data object types such as check which types are available, search for 
specific types, understand the relationship between types, and view instances of a 
particular type.
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Figure 1

Viewing a Data Object
The Schema Browser dashboard allows you to browse through the vFoglight 
Management Server connections and view the structure of the database and the schema 
objects to understand the structure and dependencies of the objects. 

To view an object:

1 On the navigation panel, under Dashboards, click vFoglight > Schema > 
Schema Browser.

2 Find the data type in the list. 

• To apply a filter to narrow down the search criteria, type a character in the 
Filter box (for example, “Host”) and press Enter. 

• To see the full list of data types, clear the Filter and press Enter.

3 When you select an object type, you can sort by various constituents of the object 
by using the View by options: Properties, Ancestors, Decendants, and 
Instances.
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Cleaning up Data Objects
The vFoglight Data Management dashboard is useful for inspecting and deleting data 
objects, and particularly for cleaning up objects that are no longer needed. For instance, 
if a set of agents is no longer required, the objects created by those agents will still be 
visible in the user interface. Removing these objects can have a positive impact on the 
performance of vFoglight and ensure that only necessary information is maintained in 
the database.

As an example, deleting agent instances from the Services dashboard removes the agent 
definitions. However, you can still view the agent entries in other dashboards such as 
the dashboard for Oracle. To remove the agent entries from these dashboards, you need 
to delete the agents using the vFoglight Data Management dashboard to remove the 
services and OracleModel Instances that was created for the Oracle dashboard. 

Deleting a Data Object
The Delete option removes an object and all of its children. If you delete an object that 
is still active, it will be re-created.

Note Metrics are always preserved and deleted as part of this topology maintenance operation.

Figure 2

To delete a data object:

1 On the navigation panel, under Dashboards, click vFoglight > Servers > Data 
Management. 

2 Drill-down to the data object you want to delete.

3 Click Delete  beside the object to remove the object and all of its children.

4 Click Yes to the “Are you sure you want to delete this object” confirmation 
message.
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Selecting Metrics to Compare
You can select host metrics in the chart on the vFoglight Data Management dashboard 
to compare metric data in chart form.

To select other metrics to compare:

1 On the navigation panel, under Dashboards, click vFoglight > Servers > 
vFoglight Data Management. 

2 Click a host object in the table to display a popup with additional information, 
such as the following:

3 Click Select Metrics to Compare. 

4 If there is other data to display, select one or more metrics to display it in the 
chart.

5 The selected metrics are displayed in the chart. 
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Adding Other Metrics to the Chart
Using the Metric Viewer you can add other metrics to view in a chart. This Viewer also 
contains a table that lists the start and end times when data was collected and the 
average for each collection period.

To add other metrics to the chart:

1 On the navigation panel, under Dashboards, click vFoglight > Servers > 
vFoglight Data Management. 

2 Click a host object in the table to display a popup with additional information.

3 Click a line in the metrics chart to open the Metric Viewer. 
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4 To display another metric, select the metric from the drop-down list. For example, 
interrupts.

5 The selected metrics (i.e. availablePagingSpace and interrupts) displays in the 
chart.
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Viewing Server Metrics
The Management Server Metrics dashboard consists of a tree view and a display area. 
You can select a server or data object from the tree view and view the metrics of 
particular objects by drag and drop. 

To view the vFMS metrics:

1 On the Navigation panel, under Dashboards, click vFoglight > Servers > 
Management Server Metrics.

2 Drill-down in the tree view to find the server or data object and drag it to the 
display area to view the data in the chart.

3 To choose the number of Columns to display the view, click 1, 2, or 3.
Note When displaying charts, it is not recommended to use 3 columns since this can skew 

the presentation of data.
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For details on viewing charts, see “Tooltips, Dwells, and Popups” on page 50.
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Looking at Server Details
The Management Server View dashboard is useful for examining the performance of 
vFMS (vFoglight Management Server). You can also use this dashboard to look for root 
causes of performance problems with vFoglight.

To view details of the vFMS:

1 On the Navigation panel, under Dashboards, click vFoglight > Servers > 
Management Server View.

2 Choose a vFoglight Server from the drop-down list to display the various views.

The views display the following information:

• Rule Service view—shows the number of bound rulettes for processing rules and 
derived metrics. (For information about rulettes, see the Administration and 
Configuration Guide.)

• Data Service view—shows the ability of the server to keep up with incoming 
data.

• JVM view—shows the memory performance of the JVM running vFoglight.
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• JDBC Connection Pool view—shows how many connections are in use at any 
time. 

• FSM Database Size view—shows the size of the database.

The combination of these five views gives a good overview of the performance of the 
vFoglight environment. 

For details on viewing charts, see “Tooltips, Dwells, and Popups” on page 50.

Viewing MySQL Database Details 
The MySQL Database Overview dashboard contains charts that display data about the 
embedded or external MySQL database. 

Note If you are using an external Oracle database, the views in this dashboard will be blank.

Figure 3

To view the MySQL database details:

1 In the navigation panel, under Dashboards, click vFoglight > Servers > 
MySQL Database Overview.
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2 Consult the views on this dashboard, which display the following information:

• Row Operations
• Database Buffer Pool Status
• Database Data I/O
• Database Pare I/O

For details on viewing charts, see “Tooltips, Dwells, and Popups” on page 50.

Viewing Persistence Handler Details
The Persistence Handler Overview dashboard contains charts that display information 
about the persistence handler such as the number of rows in the table, data length, index 
length, batch insert time, and query time.

Figure 4
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To view details on the Persistence Handler Dashboard:

1 In the navigation panel, under Dashboards, click vFoglight > Servers > 
Persistence Handler.

2 Consult the views on this dashboard, which display the following information:

• Number of rows in the table
• Size of the table
• Batch insert time
• Query time

For details on viewing charts, see “Tooltips, Dwells, and Popups” on page 50.
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Working with Applications

This section describes the Applications module dashboard. 

This chapter contains the following sections:

Monitoring an Application ..........................................................................................................154
Building an Application ..............................................................................................................155
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Monitoring an Application
You use the Application Details dashboard to monitor the details of a single application. 
It shows the structure of the application (tiers and flows), as well as the alarms for the 
application and its service impact. 

Figure 1

The following views appear on the Application Details dashboard:

• Tier Overview view contains an icon for each tier. Clicking an icon opens a view 
with details of that tier and links to related views.

• Application Contents view lists the components of the selected application. For 
each component it indicates the state of health, number of each type of alarm, and 
health history.
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• Outstanding Alarms view lists alarm information for the selected application. 
For a description of this view, see “Alarm List” on page 58.

• Service Impact view lists services that may be affected by a problem with the 
selected application.

Building an Application
An application is a set of tiers in which each tier contains a set of monitored elements, 
such as hosts and servers. A tier has a defined flow that represents the data moving from 
the user to the back-end systems.

The Application Builder dashboard is where you create a new application from scratch. 
It contains all the functions needed to build an application model in three views — one 
for each step in the process. 

Figure 2

• In the Step One view, you add tiers to an application or edit the tiers in an existing 
application.
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• In the Step Two view, you create tiers and define the flows and components for 
tiers.

• In the Step Three view, you inspect the application.

Note A new service is automatically created for a new application.

Step 1: Adding Tiers to an Application
Adding an application involves creating a set of application tiers that make up the 
different logical layers of the application. After the tiers are identified and created, they 
can be linked to show a logical flow of information. This makes it easier to understand 
the dependency between tiers. When you add vFoglight objects to the tiers, states begins 
to flow up to the tiers. The result is a model that shows which logical part of an 
application is causing a problem.

Note You can also add an application using the Service Builder Dashboard. See “Creating a New 
Application” on page 109.

To add tiers to an application:

1 In the navigation panel, expand the Applications node and select Application 
Builder. 

The Application Builder is displayed.

2 In the Step One view, click Add  or select an existing application from the 
drop-down list. 

The Application Creator dialog box appears.

3 Type a name that is unique to vFoglight for the application and click Create.

The name of the new application is added to the drop-down list in the Step One 
view.

4 Choose the new application you just created from the drop-down list.
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Step 2: Creating Tiers, Defining Tier Flows and Tier Components 
Creating Tiers
The following steps describe the procedure to create new tiers. If the tier already exists, 
you can add the tier to the application. See “Step 3: Adding Tiers to Preview the New 
Application and Tier Flows” on page 159.

To create a tier flow:

1 To create a new tier for the application, in the Step Two view click the Add icon 
.

The Tier Creator dialog box appears.

1 Select the Tier Type (e.g WebTier, DatabaseTier, etc. ) from the drop-down list.

2 Type a name for the tier and click Create.

The name of the new tier is added to the drop-down list and appears under Add a 
Tier. 

3 Continue to add new tiers to the application if required.

Defining Tier Flows
When you define tier flows you are specifying the workflow sequence from one tier to 
another.

To define a tier flow:

1 In the Step 2 view, choose the tier from the drop-down list in which the flow 
originates. 
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2 Click the Add icon  beside the tier which the flow.

3 The tier flow is added and appears under Current Flows.

4 Continue to add tier flows for the application if required.

Defining Tier Components
When defining tier components, you choose the components to add to the selected tier.

To define a tier component:

1 In the Step 2 view, choose the tier from the drop-down list .

2 Click Define Tier Components.

3 Drill-down to the component(s) you want to add and click Add  beside the 
component.
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4 The component that you added appears under the Current Components list.

Step 3: Adding Tiers to Preview the New Application and Tier 
Flows
When you have finished adding tiers to the application, you can preview the new 
application in the Stepand tier flows in the Step 3 view. 

To add Tiers to the Application:

1 Under Add a Tier, click Add  for each tier(s) you want to add to the new 
application.

2 The tiers you added moves to the list under Current Tiers and you can preview the 
application tiers and flows in the step 3 view.
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3 Click the icon for each tier and choose one of the links to view its monitored hosts 
and agents, a summary of metrics by host and agent, or a list of its properties.

When you have finished building the application, you can check the Services dashboard 
to confirm that the service that was created for the application is listed in the Categories 
and Services view.

Removing an Application, Tier, Tier Flow, or Tier Component
Use the following procedure to remove an application, tier, tier flow, or tier component 
that is no longer required.

To remove an application, tier, or tier flow, or tier component:

1 In the Application Builder, click Remove  for the application, tier, tier flow, 
or tier component that you want to remove.

2 If you selected to remove an application or tier, a dialog prompts you to confirm 
the deletion. From the popup, click Delete to remove the selected item. 
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Working with Reports

The Reports feature provides the ability to share data outside of vFoglight. In vFoglight, 
the tasks of report scheduling and report browsing/viewing are separated into the Report 
Manager dashboard and the Reports dashboard.

This chapter contains the following sections:

Introducing the Reports Module ................................................................................................162
Supplied Report Templates .......................................................................................................164
Working with Reports ................................................................................................................192
Managing Scheduled Reports ...................................................................................................200
Managing Generated Reports ...................................................................................................204
Working with Custom Reports ...................................................................................................213
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Introducing the Reports Module
Most users can use the Reports dashboard to run and schedule reports; however, the use 
of the Report Manager dashboard to work with scheduled reports as well as test 
(preview) report templates, and create a new schedule should be limited to those with 
advanced operator permissions.

You can create reports based on:

• Pre-defined, standard reports—out-of-the-box templates for a high-level, 
overview perspective of the data. For information on the list of supplied report 
templates, see “Supplied Report Templates” on page 164.

• Custom reports—created from any displayed dashboard. See “Working with 
Custom Reports” on page 213.

vFoglight divides the report-related functions into two separate dashboards:

• Report Manager dashboard—allows users with advanced operator permissions to 
perform the tasks of editing, copying, and managing scheduled reports, test 
(preview) report templates, create a new schedule (that is not part of the defined 
list of schedules), as well as delete scheduled and generated reports.

• Reports dashboard—available to all users who are assigned the Operator role. 
Enables operators to perform some common tasks as available in the Report 
Manager dashboard such as run or schedule a report as well as delete a report. 

Report Manager Dashboard
The Report Manager Dashboard enables you to create, edit, copy, and schedule reports, 
test report templates, and delete scheduled and generated reports. 

The Report Manager consists of four panes: 

• The top pane runs across the top of the Report Manager dashboard contains the 
icons to Run Report, Create (custom) Report, Schedule Report.

• The left-hand pane contains a hierarchical list on the left to better organize the 
reports. The report templates are grouped accordingly:

• By Module—reports are classified by the module in which the report template 
is created (for example, Services, Administration, or Host). 

• By Role—reports are grouped according to common use by a functional role.
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• All—displays all available reports. The Module column indicates the module 
in which the report was defined. 

• The upper right pane displays the Scheduled Reports view with the scheduled 
reports that have been created on the basis of the template. 

• The Name, Template, and Schedule columns for each scheduled report is 
listed. Click on a template or schedule to view details. 

• The User column lists who created the report.
• The Retain column lists how many instances of a report are kept. For 

example, if the value is 3, then when a fourth report is generated, the oldest 
one will be deleted. 

• The Disabled column indicates whether the report is not currently being 
generated (true) or is being generated (false). 

• The lower right pane displays the Generated Reports view containing the 
following columns:

• Date and Time when each scheduled report was generated, Report name, 
Size, Template, and Schedule. 

• Message column displays any error messages associated with the report. 
• View column containing the PDF output of a generated report.

To show or hide columns in the generated reports view, click the  Show/Hide 
columns and select the checkboxes beside the columns to appear.
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Reports Dashboard
The Reports dashboard is available to Operators and lists the reports which have been 
generated. You can sort the list according to date, scheduled report, size, template, 
schedule, or message. The Reports dashboard has the same view as the Generated 
Reports area that is in the Report Manager dashboard, except that the Reports dashboard 
shows all reports that were generated in the Generated Reports view. The Report 
Manager dashboard shows reports according to the type of scheduled report as well as 
generated reports.

You can also use the Reporting dashboard to run a report using a report template, create 
a custom a report, and schedule a report to run at a later date. 

To navigate to the Report Manager dashboard from the Reports dashboard, click the  
Manage Reports icon. Note that you will need Advanced Operator permissions to do 
so.

To filter the shown reports based on search text see “Applying a Filter to Generated 
Reports” on page 206.

To show or hide columns in the Generated Reports view, click the  Show/Hide 
columns and select the checkboxes beside the columns you want to appear.

Supplied Report Templates
Reports are created based on existing templates. Before you can create a report, you 
must know the template’s capabilities. Different reports use different parameters; these 
parameters define the content of the report
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vFoglight contains a number of pre-defined, overview type reports based on default 
templates that you can use as they are or edit to meet your requirements. Each one 
serves a particular purpose however, there are multiple report templates that have the 
same expected inputs. The predefined report templates allow you to quickly generate 
reports with the option of setting and changing the values in the report inputs. The 
supplied templates are described on the following pages.

You can also create a custom report, which is similar to creating a dashboard. When you 
create a custom report, it is added to the report templates list. See “Creating a Custom 
Report Template” on page 213. 

Note Most of the pre-defined reports have grid components that do not support CSV (Comma 
Separated Value) output. 

This section also lists the possible report inputs that are available for each supplied 
report template. The contents of the report input dialogs vary depending on the type 
value you are editing. You can set your own specialized parameters by specifying values 
for the report inputs using the Web Component Framework which is used to build all the 
views in the vFoglight user interface. For more information on context input and values, 
see the Web Component Guide and Web Component Reference.

Event Analysis for Any Resources Report
Provides an overview of the events for the given topology objects grouped by severity.
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Report Inputs

Report Input Description of Values

timeRange Specify a period of time to report from. TimeRange for a 
metric observation can be specified in various ways, but it is 
always composed of a range of date-time objects, and a 
granularity. Select:
• TimeRange Type: Choose one:

- Last N (to display the time range for the last <number> 
<unit>) For example, last 2 months.
- Calendar Aligned (enter a time range and offset number)
- Custom (choose the date range on the calendar)

• Unit: select the timeframe (e.g. Year, Month, etc)
• Number/Offset: enter a value for the timerange.
• Granularity: Choose one: 

- RAW—data observations are shown in the metric history 
with the smallest available granularity, or a number of 
milliseconds, for example, 300,000 for 5 minutes. 
- AUTO—the system will pick the best granularity based 
on the time range. For example, a numeric value of -2
- a specific time interval from the drop-down (e.g. 1 
minute).
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Event Analysis for Hosts Report
Provides a summary of events for the given hosts grouped by severity. Also displays 
the count, alarm message, last issued, and state history for each event, if applicable. 

topology objects Required. Use the Topology layout to define different views 
for up to four zoom levels of combinations to display a tree 
of objects descending from a defined Root Object, which is 
either:
• Data (for a single object of that data type)
• List (specifying a list of objects for that data type) 
Select an object by navigating to the data node to find the 
data source for the object.

You can also use:
• Query Selection—to use WCF queries that are similar to 

SQL queries to select a subset of information in a data 
source. 

• Invoke Function—to invoke a function run-time value by 
specifying a null parameter.

Report Input Description of Values
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Report Inputs

Report Input Description of Values

timeRange Specify a period of time to report from. TimeRange for a 
metric observation can be specified in various ways, but it is 
always composed of a range of date-time objects, and a 
granularity. Select:
• TimeRange Type: Choose one:

- Last N (to display the time range for the last <number> 
<unit>) For example, last 2 months.
- Calendar Aligned (enter a time range and offset number)
- Custom (choose the date range on the calendar)

• Unit: select the timeframe (e.g. Year, Month, etc)
• Number/Offset: enter a value for the timerange.
• Granularity: Choose one: 

- RAW—data observations are shown in the metric history 
with the smallest available granularity, or a number of 
milliseconds, for example, 300,000 for 5 minutes. 
- AUTO—the system will pick the best granularity based 
on the time range. For example, a numeric value of -2
- a specific time interval from the drop-down (e.g. 1 
minute).

fsmService Returns a list of objects representing the FSM service by 
using one of the following:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and navigate to the data node to 
find the data source for the object.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value by 
specifying a null parameter.

longNameLike Returns a list of values matching the string.



Working with Reports 171
Supplied Report Templates
Physical Host - CPU Utilization Monthly Summary Report
Provides a monthly summary of host CPU utilization.

maxHosts Returns a list of objects representing the maximum hosts. 
Choose either:
• Integer—enter an integer value 
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and select a node.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value.

Report Input Description of Values
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Report Inputs

Physical Host - Memory Utilization Monthly Summary Report
Provides a monthly summary of a host’s memory use.

Report Input Description of Values

nMonths Type an integer value to denote the number of months.

fsmService Returns a list of objects representing the FSM service by 
using one of the following:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and navigate to the data node to 
find the data source for the object.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value by 
specifying a null parameter.

longNameLike Returns a list of values matching the string.

maxHosts Returns a list of objects representing the maximum hosts. 
Choose either:
• Integer—enter an integer value. 
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and select a node.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value.
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Report Input Description of Values

nMonths Type an integer value to denote the number of months.

fsmService Returns a list of objects representing the FSM service by 
using one of the following:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and navigate to the data node to 
find the data source for the object.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value by 
specifying a null parameter.

longNameLike Returns a list of values matching the string.

maxHosts Returns a list of objects representing the maximum hosts. 
Choose either:
• Integer—enter an integer value 
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and select a node.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value.
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Physical Host - Network Utilization Monthly Summary Report
Provides a monthly summary of host network utilization.
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Physical Host Utilization Summary - Last 10 Days Report
Lists the host CPU, Memory, Disk and Network data over the last 10 days.

Report Input Description

nMonths Type an integer value to denote the number of months.

fsmService Returns a list of objects representing the FSM service by 
using one of the following:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and navigate to the data node to 
find the data source for the object.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value by 
specifying a null parameter.

longNameLike Returns a list of values matching the string.

maxHosts Returns a list of objects representing the maximum hosts. 
Choose either:
• Integer—enter an integer value 
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and select a node.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value.
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Report Input Description

timeRange Specify a period of time to report from. TimeRange for a 
metric observation can be specified in various ways, but it is 
always composed of a range of date-time objects, and a 
granularity. Select:
• TimeRange Type: Choose one:

- Last N (to display the time range for the last <number> 
<unit>) For example, last 2 months.
- Calendar Aligned (enter a time range and offset number)
- Custom (choose the date range on the calendar)

• Unit: select the timeframe (e.g. Year, Month, etc)
• Number/Offset: enter a value for the timerange.
• Granularity: Choose one: 

- RAW—data observations are shown in the metric history 
with the smallest available granularity, or a number of 
milliseconds, for example, 300,000 for 5 minutes. 
- AUTO—the system will pick the best granularity based 
on the time range. For example, a numeric value of -2
- a specific time interval from the drop-down (e.g. 1 
minute).

fsmservice Returns a list of objects representing the FSM service by 
using one of the following:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and navigate to the data node to 
find the data source for the object.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value by 
specifying a null parameter.

longNameLike Returns a list of values matching the string.
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Management Server Performance Summary Report
Displays current vFoglight Server performance information, including DB metric, JVM, 
and agent connectivity.

maxHosts Returns a list of objects representing the maximum hosts. 
Choose either:
• Integer—enter an integer value 
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and select a node.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value.

Report Input Description
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Figure 1
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Report Input Description

timeRange Specify a period of time to report from. TimeRange for a 
metric observation can be specified in various ways, but it is 
always composed of a range of date-time objects, and a 
granularity. Select:
• TimeRange Type: Choose one:

- Last N (to display the time range for the last <number> 
<unit>) For example, last 2 months.
- Calendar Aligned (enter a time range and offset number)
- Custom (choose the date range on the calendar)

• Unit: select the timeframe (e.g. Year, Month, etc)
• Number/Offset: enter a value for the timerange.
• Granularity: Choose one: 

- RAW—data observations are shown in the metric history 
with the smallest available granularity, or a number of 
milliseconds, for example, 300,000 for 5 minutes. 
- AUTO—the system will pick the best granularity based 
on the time range. For example, a numeric value of -2
- a specific time interval from the drop-down (e.g. 1 
minute).

description Specify a string value describing the report.

FoglightServer Select a vFoglight server. 
Alternatively, click Show Advanced to returns a list of 
objects representing the FSM service by using one of the 
following:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and navigate to the data node to 
find the data source for the object.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value by 
specifying a null parameter.
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Physical Host Load Summary Report
The Hosts Summary report provides a host summary for the CPU, memory, file system, 
and network usage.

currentTime Use the calendar to specify the current time of the report.

Report Input Description
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Figure 2
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Report Input Description of Values

timeRange Specify a period of time to report from. TimeRange for a 
metric observation can be specified in various ways, but it is 
always composed of a range of date-time objects, and a 
granularity. Select:
• TimeRange Type: Choose one:

- Last N (to display the time range for the last <number> 
<unit>) For example, last 2 months.
- Calendar Aligned (enter a time range and offset number)
- Custom (choose the date range on the calendar)

• Unit: select the timeframe (e.g. Year, Month, etc)
• Number/Offset: enter a value for the timerange.
• Granularity: Choose one: 

- RAW—data observations are shown in the metric history 
with the smallest available granularity, or a number of 
milliseconds, for example, 300,000 for 5 minutes. 
- AUTO—the system will pick the best granularity based 
on the time range. For example, a numeric value of -2
- a specific time interval from the drop-down (e.g. 1 
minute).

fsmService Returns a list of objects representing the FSM service by 
using one of the following:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and navigate to the data node to 
find the data source for the object.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value by 
specifying a null parameter.

longNameLike Returns a list of values matching the string.
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Physical Host Performance Details Report
Provides an overview of the host system data over a given time range including CPU, 
Memory, File System and Network metrics.

maxHosts Returns a list of objects representing the maximum hosts. 
Choose either:
• Integer—enter an integer value 
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and select a node.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value.

Report Input Description of Values
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Figure 4
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Figure 5

Figure 6
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Report Input Description of Values

timeRange Specify a period of time to report from. TimeRange for a 
metric observation can be specified in various ways, but it is 
always composed of a range of date-time objects, and a 
granularity. Select:
• TimeRange Type: Choose one:

- Last N (to display the time range for the last <number> 
<unit>) For example, last 2 months.
- Calendar Aligned (enter a time range and offset number)
- Custom (choose the date range on the calendar)

• Unit: select the timeframe (e.g. Year, Month, etc)
• Number/Offset: enter a value for the timerange.
• Granularity: Choose one: 

- RAW—data observations are shown in the metric history 
with the smallest available granularity, or a number of 
milliseconds, for example, 300,000 for 5 minutes. 
- AUTO—the system will pick the best granularity based 
on the time range. For example, a numeric value of -2
- a specific time interval from the drop-down (e.g. 1 
minute).

fsmService Returns a list of objects representing the FSM service by 
using one of the following:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and navigate to the data node to 
find the data source for the object.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value by 
specifying a null parameter.

longNameLike Returns a list of values matching the string.
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Physical Host Performance Summary Report
Provides an overview of the current host system data including CPU, memory, and file, 
and network. 

maxHosts Returns a list of objects representing the maximum hosts. 
Choose either:
• Integer—enter an integer value 
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and select a node.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value.

Report Input Description of Values
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Report Input Description of Values

timeRange Specify a period of time to report from. TimeRange for a 
metric observation can be specified in various ways, but it is 
always composed of a range of date-time objects, and a 
granularity. Select:
• TimeRange Type: Choose one:

- Last N (to display the time range for the last <number> 
<unit>) For example, last 2 months.
- Calendar Aligned (enter a time range and offset number)
- Custom (choose the date range on the calendar)

• Unit: select the timeframe (e.g. Year, Month, etc)
• Number/Offset: enter a value for the timerange.
• Granularity: Choose one: 

- RAW—data observations are shown in the metric history 
with the smallest available granularity, or a number of 
milliseconds, for example, 300,000 for 5 minutes. 
- AUTO—the system will pick the best granularity based 
on the time range. For example, a numeric value of -2
- a specific time interval from the drop-down (e.g. 1 
minute).

fsmService Returns a list of objects representing the FSM service by 
using one of the following:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and navigate to the data node to 
find the data source for the object.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value by 
specifying a null parameter.

longNameLike Returns a list of values matching the string.
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Service Level Summary Report
Provides service level summary information including alarm information and 
availability over a given time range.

maxHosts Returns a list of objects representing the maximum hosts. 
Choose either:
• Integer—enter an integer value 
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type. 
Drill-down to the object and select a node.

• Query Selection—uses WCF queries that are similar to 
SQL queries to select a subset of information in a data 
source.

• Invoke Function—invokes a function run-time value.

Report Input Description of Values
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Report Input Description of Values

timeRange Specify a period of time to report from. TimeRange for a 
metric observation can be specified in various ways, but it is 
always composed of a range of date-time objects, and a 
granularity. Select:
• TimeRange Type: Choose one:

- Last N (to display the time range for the last <number> 
<unit>) For example, last 2 months.
- Calendar Aligned (enter a time range and offset number)
- Custom (choose the date range on the calendar)

• Unit: select the timeframe (e.g. Year, Month, etc)
• Number/Offset: enter a value for the timerange.
• Granularity: Choose one: 

- RAW—data observations are shown in the metric history 
with the smallest available granularity, or a number of 
milliseconds, for example, 300,000 for 5 minutes. 
- AUTO—the system will pick the best granularity based 
on the time range. For example, a numeric value of -2
- a specific time interval from the drop-down (e.g. 1 
minute).

SLA Required. Choose a method to return a list of objects 
representing the FSM ServiceLevelPolicy by using one of 
the following functions:
• Data—displays a tree of objects descending from a 

defined Root Object, for a single object of that data type.
• Query Selection—to use WCF queries that are similar to 

SQL queries to select a subset of information in a data 
source.

• Invoke Function—to invoke a function run-time value by 
specifying a null parameter.
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This section describes the functions that are available to work with reports such as run a 
report, schedule a report, test a report template, and add a new schedule to the default 
report schedules list. The tasks of running a report and scheduling a report are available 
in both the Reports dashboard and Report Manager dashboard. The Test and New 
Schedule buttons are only accessible in the Report Manager dashboard.

Running a Report
The Run Report option on the Reports Manager dashboard or the Reports dashboard 
enables you to choose a report from the report template list and run the report so you can 
view the PDF output of the report immediately without having to schedule the report. 
The resulting report appears in the Generated Reports table.

When you run a report you do not attach a schedule to it. To schedule the report to run 
on a particular date and time, see “Scheduling a Report” on page 194.

When choosing a template in the Run Report option you can specify values for the 
report inputs or leave the report values without attaching any values to it. 

To run a report:

1 In the navigation panel, under Dashboards, click Reports > Report Manager. If 
you do not have access to the Report Manager dashboard, click Reports > 
Reports. 

2 Click Run Report  to open the Run Report dialog box.

3 Complete the entries in the Run Report dialog box:
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a Report Template—click Please click here to select template and drill-down 
to the report template on which to base your report. To help you focus on the 
source of the report, when choosing a report you can select by module, role or 
all.

• Click the report template you want to use. 

The dialog box populates with the data for the template you selected.

• You can leave the report inputs as is or tailor the report by specifying report 
input values according to your business requirements. To specify an input 
value to this report, click the  Edit icon in the Value column of the 
Report Inputs table to open an edit dialog. The contents of this dialog vary 
depending on the type value you are editing. For example, an input can be a 
time range that determines the range of data to display. For information on 
report inputs, see the Report input section for the appropriate report template 
in “Supplied Report Templates” on page 138. If a Report Input is marked as 
required under the Usage column, a value must be set to create the scheduled 
report. If you enter a new value click Set.

For more information on the Web Component Framework and context inputs, 
see the Web Component Guide and Web Component Tutorial.

b Name—type a unique name for the report. This is a required field.
Note If you are using a template in which the host name is required, you must enter the 

host name in the text field exactly as it appears at the top of the reports.

c View Now—select the check box to view the PDF output of the report 
immediately.

d Report Format—select PDF to create the report in PDF format. 
Note The CSV option does not appear for pre-defined reports (with the exception of 

the vFMS Database View diagnostic report) since most pre-defined reports are 
not capable of generating meaningful CSV data. To generate a CSV report, the 
component type of the report must support CSV output. For details, see 
“Creating a CSV Report” on page 215. 

e Email Recipients—type the recipient’s email address in the text box to send 
an email notification about this report. For multiple email recipients, you can 
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enter a list of comma-separated email addresses however, you must restart the 
vFoglight Management Server.
Note To send reports to email recipients from the Report Manager, you must configure 

the e-mail server by enabling the “Email Reports Sample” rule. By default, this 
rule is disabled. When enabling the rule you may also have to edit the “Fire” 
condition to filter the reports before sending them to email recipients. For more 
information, see the vFoglight Administration and Configuration Guide under 
“Working with vFoglight Rules and Registry > Working with Rules > Defining 
Conditions, Alarms, and Actions > Defining actions > vFoglight actions > Viewing 
email settings and configuring email actions”.

4 Click Run to generate the report immediately in PDF format. 

Scheduling a Report
Select the Schedule Report option on the Reports Manager dashboard or the Reports 
dashboard to create a report using the report template list and then scheduling the report 
to run at a particular time. You have the option to leave the report input values as is or 
tailor the report by specifying input values according to your business requirements. 

Note You can also schedule a report that has generated. See “Scheduling a Generated Report” 
on page 208.

If you want to define a new schedule other than the out-of-box schedules provided with 
vFoglight, see “Adding a New Schedule” on page 198.

To schedule a report:

1 In the navigation panel, under Dashboards, click Reports > Report Manager. If 
you do not have access to the Report Manager dashboard, click Reports > 
Reports. 

2 Click Schedule Report  to open the Scheduled Report dialog box. You can 
schedule a report by either:

• Choosing a template from the Reports list in the Reports Manager dashboard:
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If you chose this option, when clicking Schedule Report, the Create Scheduled 
Report populates automatically with data for the selected template.

• Choosing Schedule Report from the top pane of the Reports dashboard or 
Reports Manager dashboard.

If you chose this option you will need to click Please select report template.
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Drill-down to the report template on which to base your report. Select a template 
on which to base your report from the Report Template column. To help you 
focus on the source of the report, choose a report based on their classification: By 
Module, By Role, or All.

If you choose this option, the dialog automatically populates with the data for the 
template you selected.

3 Complete the remaining entries in the Create Scheduled Report dialog box:

• Report Inputs—if you want to specify a value of an input to this report, click 
the  Edit icon in the Value column of the Report Inputs table to open an edit 
dialog. The contents of this dialog vary depending on the type value you are 
editing. For example, an input can be a time range that determines the range of 
data to display. For information on report inputs, see the Report input section 
for the appropriate report template in “Supplied Report Templates” on 
page 164. 
If a Report Input is marked as required under the Usage column, a value must 
be set to create the scheduled report.
If you enter a new value click Set.
For more information on the Web Component Framework and context inputs, 
see the Web Component Guide and Web Component Tutorial.
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• Name—type a unique name for the report. This is a required value.
Note If you are using a template in which the host name is required, you must enter the 

host name in the text field exactly as it appears at the top of the reports.

• Schedule—choose when to run the report. For example, choose “End of day” 
to run the report on an end-of-day schedule.
To create a schedule that is not in the list, see “Adding a New Schedule” on 
page 198.

• Retained Results—choose a value to indicate how many instances of a report 
to keep. This is a required field. For example, if the value is 3, then when a fourth 
report is generated, the oldest report will be deleted.
• Enabled—the checkbox to set report generation is selected by default.
• Report Format—select PDF to create the report in PDF format. 
Note The CSV option does not appear for pre-defined reports (with the exception of the 

vFMS Database View diagnostic report) since most pre-defined reports are not 
capable of generating meaningful CSV data. To generate a CSV report, the 
component type of the report must support CSV output. For details, see “Creating a 
CSV Report” on page 215. 

• Email Recipients—type the recipient’s email address in the box to send an 
email notification about this report. For multiple email recipients, you can 
enter a list of comma-separated email addresses however, you must restart the 
vFoglight Management Server.

Note To send reports to email recipients from the Report Manager, you must configure the 
e-mail server by enabling the “Email Reports Sample” rule. By default, this rule is 
disabled. When enabling the rule you may also have to edit the “Fire” condition to 
filter the reports before sending them to email recipients. For more information, see 
the vFoglight Administration and Configuration Guide under “Working with vFoglight 
Rules and Registry > Working with Rules > Defining Conditions, Alarms, and Actions 
> Defining actions > vFoglight actions > Viewing email settings and configuring email 
actions”.

4 Click Create to create and schedule the report. The report appears in the 
Scheduled Reports View. See “Managing Scheduled Reports” on page 200.

When the report is generated, it will appear in the Generated Reports view. See 
“Viewing a Generated Report” on page 204.

Testing a Report Template
If you have the appropriate permissions, you can use the Test button on the Report 
Manager dashboard as a quick and easy way to preview a report template without 
having to create a scheduled report nor generate the report.
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To test a selected report template: 

1 In the navigation panel under Dashboards, click Reports > Report Manager. 

2 Create a report based on a pre-defined or custom template. For a pre-defined 
report template, see “Supplied Report Templates” on page 164. For custom report 
templates, see “Creating a Custom Report Template” on page 213.

3 Click  Test.

A test dialog box with the context inputs for the selected report appears.

4 You can optionally enter context input values for the report. If a Report Input is 
marked as required under the Usage column, a value must be set to preview the 

report. To change the value of a context input value click . By entering 
values for the context input you can set your own specialized parameters using 
the Web Component Framework which is used to build all the views in the 
vFoglight user interface. If you specify a context input value, make sure you click 
Set. For information on report inputs, see the Report input section for the 
appropriate report template in “Supplied Report Templates” on page 164. For 
more information on the Web Component Framework and context inputs, see the 
Web Component Guide and Web Component Tutorial. 

5 Click Test to view a PDF output of the report template.

Adding a New Schedule
If the schedule options available in the Report Manager do not meet your needs, you can 
define a new schedule to fit your requirements. For more information about schedules, 
see the Administration and Configuration Guide.

To add a new schedule:

1 In the Report Manager dashboard, click  New Schedule.

2 Type a unique name for the schedule in the Schedule Name field. 

3 Add an optional description about the schedule in the Description/Comments 
field. 
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4 Click Next to go to the Details of Schedule page. 

5 Set the Start Date using the fields and drop-down menu, or click the browse 
button ( ) to open a calendar where you can select the start date. 

6 Enter a Start Time and End Time, or select the Whole Day check box if you 
want the schedule to cover the whole day. The Whole Day check box may or may 
not be available depending on the Recurrence Pattern you select. For example, it 
does not appear for the Recurrence Pattern "Once" (which is the default option.) 
Note The End Time must be later than the Start Time. 

7 Choose an option under Recurrence Pattern:

• Once—to specify the schedule to execute only one time during the specified 
start and end time.

• Periodical—specify the hour and minute that the report will run. For example, 
type 06:00 to run the report every 6 hours.

• Daily—specify the number of days the report will run. For example, type 2 to 
run the report every 2 days.

• Weekly—specify the number of weeks and the days that the report will run. 
For example, to run the report to schedule every 2 weeks on Friday, type 2 and 
select Friday.

• Monthly—select to run the report by date or by week. 
For example, to run the report by date you can run the report every 6th day 
each month. Type 6 in the Day box and type 1 in the month field.
If you select to run the report by week, select the week (First, Second, Third, 
Fourth, or Last), the weekday and monthly frequency. For example, you can 
schedule the report to run on the last week of every Tuesday every 2 months.

• Yearly—select the report to run by date or by week.
For example, to run the report by date you can run the report on a particular 
day on the selected month such as every December 31.
If you select to run the report by week, select the week (First, Second, Third, 
Fourth, or Last), the weekday and the month. For example, you can choose to 
specify the report to run on the last week on Friday every December.

8 Choose an option under Range of Occurrence (the period during which the 
schedule will recur). 

If you selected an option other than Once as the recurrence pattern, you can select 
the No End option button to cause the schedule to recur indefinitely, or set an 
End By Date using the fields and drop-down menu or by clicking the browse 
button ( ) to open a calendar from which you can select the end date. 
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9 Click Add to create the schedule.

Managing Scheduled Reports
After you scheduled a report, the report appears in the Scheduled Reports view in the 
Reports Manager dashboard where you can edit, copy, enable/disable, and delete 
scheduled reports.

For information on creating a report with a schedule, see “Scheduling a Report” on 
page 194.

Editing a Scheduled Report
You can change any or all the parameters of a scheduled report.

To edit a scheduled report:

1 In the Scheduled Reports with Filter view of the Report Manager dashboard, click 
the edit icon  beside the report that you want to edit.

The Edit Scheduled Report dialog opens.
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2 Make your changes (see “Supplied Report Templates” on page 164 to create a 
report using the report template list. You have the option to leave the report values 
as is or tailor the report by specifying the input values according to your business 
requirements. 

3 Click Save to save your changes.

Copying a Scheduled Report
You can create a new scheduled report by copying an existing one and changing one or 
more of the parameters.

To copy a scheduled report:

1 In the Scheduled Reports with Filter view of the Report Manager dashboard, click 
the copy icon  beside the report that you want to edit.

The Copy Scheduled Report dialog box opens.
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2 Make your changes (see “Supplied Report Templates” on page 164 for details 
about the parameters).

3 Click Create to create a copy of the report. 

Disabling/Enabling a Scheduled Report
When a scheduled report is created, it is enabled by default. You can disable a report, 
which means that it will not run at the scheduled time until it is enabled again. 

To disable a scheduled report:

1 In the Scheduled Reports with Filter view of the Report Manager dashboard, click 
the check box(es) beside the report(s) that you want to disable.

2 Click Manage Scheduled Reports. 

3 In the popup, click Disable. 

In the Disabled column, the value changes from false to true.

To enable a disabled report, click Enable in the popup menu. The value in the Disabled 
column changes to false.
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Deleting a Scheduled Report
When you delete a scheduled report, any generated reports that are associated with it are 
also deleted.

To delete a scheduled report:

1 In the Scheduled Reports with Filter view of the Report Manager dashboard, 
select the check box(es) beside the report(s) that you want to delete.

2 Click Manage > Delete.. 

3 In the popup menu, click Delete. 

A dialog prompts you to confirm the deletion.

4 Click Delete. 

The report is removed from the list of scheduled reports and all generated reports 
associated with it are removed from the list of generated reports.

Applying a Filter to Scheduled Reports
Creating a filter on scheduled reports helps you find reports based on criteria such as the 
report name, template, schedule or if the report was enabled. 

To apply a filter to a report:

1 In the navigation panel, under Dashboards, click Reports > Report Manager.

2 In the Scheduled Reports view, click Scheduled Report Filter Not Set. 



204 vFoglight
User Guide 
3 Enter the criteria for the filter based on criteria such as a report name, template, 
schedule (such as “day” for end of day reports), or enabled (True or False). 

4 Click Find to output the reports that match the filter condition. 

5 If you want to apply another filter, click Clear and repeat steps 2 to 3. 

Managing Generated Reports
Reports that have generated appear in the Generated reports view in both the Reports 
dashboard and Report Manager dashboard. The Generated reports view contains reports 
that were generated when clicking Run Report and Schedule Report icons.

Figure 7

Viewing a Generated Report 
As a convenient way of visualizing the data, you can view report details or reports can 
be output to a PDF on a ongoing basis. Operators can view and output a generated 
report in the Reports dashboard. Advanced operators can access the Report Manager 
dashboard to view report details or produce a PDF output of a generated report. 

To view PDF reports, Adobe Acrobat Reader version 7.0.9 or later is preferred.

To view a report that has been generated:

1 In the navigation panel, under Dashboards, click Reports > Report Manager. If 
you do not have access to the Report Manager dashboard, click Reports > 
Reports. 

• To view details of a generated report, hover over  Report Details or PDF.



Working with Reports 205
Managing Generated Reports
2 To view the PDF output of the report, click the PDF link next to the report.

3 Click  View Report. 

The PDF output of the report is displayed. 
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Applying a Filter to Generated Reports
Creating a filter on a generated report helps you find reports based on criteria such as 
the report name, template, schedule or the date range for which the report was run. 

To apply a filter to a generated report:

1 In the navigation panel, under Dashboards, click Reports > Report Manager. If 
you do not have access to the Report Manager dashboard, in the navigation panel, 
under Dashboards, click Reports > Reports.

2 In the Generated Reports view, click Report Filter Not Set.

3 In the Report Filter Not Set dialog box, enter the criteria for the filter such as 
report name, template, schedule (such as “day” for end of day reports), or specify 
a time range for the report on the Date Run fields.
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• If you select the Earliest Available check box, enter the period end date in the 
To fields. 

• If you select the Current Date check box, enter the start date in the From 
fields.

4 To have the report filter generate manually, select the True check box.

5 Click Find to output the reports that match the filter condition. 

6 If you want to apply another filter, click Clear and repeat steps 2 to 5. 

Deleting a Generated Report
To delete a generated report:

1 In the navigation panel under Dashboards, click Reports > Report Manager. If 
you do not have access to the Report Manager, in the navigation panel, under 
Dashboards, click Reports > Reports.

2 In the Generated Reports view, click the check box beside the report(s) that you 
want to delete. 

3 For generated reports, click  Delete from the menu.

A dialog box asks you to confirm the deletion.

4 Click Delete to delete the report from the list of generated reports.
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Scheduling a Generated Report
You can re-schedule or add another schedule to a report that has generated. 

To schedule a generated report:

1 In the navigation panel under Dashboards, click Reports > Report Manager. If 
you do not have access to the Report Manager, in the navigation panel, under 
Dashboards, click Reports > Reports.

2 In the Generated Reports view, click the check box beside the report(s) that you 
want to schedule. 

3 Click PDF for the generated report you want to schedule.

4 In the dialog box that appears, click Schedule Report: 

Now you can attach a new schedule or re-schedule the report. To schedule the 
report, see “Scheduling a Report” on page 194.

Adding Your Own Logo to Reports
You can add your own company logo or a logo of your choice to replace the Vizioncore 
logo that appears on the top-left corner of reports. This section shows how you can 
replace the logo for out-of-the-box, pre-defined reports. 

To add your own logo to out-of-the-box reports:

1 From the Generated Reports view of the Reports dashboard or Report 
Manager dashboard, click the PDF for the report to view it. As an example, you 
will change the default logo that appears on the out-of-the-box report: Rolling 
CPU Utilization.
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2 To edit the image on the top left of the report, click Configuration > Definitions 
on the left-hand panel. In the content page, expand Reports and click Canned 
Reports. From the list of Views in the lower left-hand pane, select CPU 
Utilization (Rolling N Month Summary).

3 Scroll down on the right-hand pane for the CPU Utilization (Rolling N Month 
Summary) view and click the hyperlink for the embedded view Header: Logo, 
Title, Time Range. 
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The Header Logo view opens.

4 To upload the image you want to use for your reports, return to the lower left-
hand pane and click the Files tab. Click Add and then click Browse... to upload 
the image.
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5 Click the Header: Logo, Title, Time Range tab. Click Edit and select the 
Configuration tab.

6 Select the drop-down icon next to the Value for the row Left Image. Select the 
Image Reference link. 
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7 In the pop-up window, locate the image you just uploaded. It should be located 
under Reports > Canned Reports.

8 Click Save to keep this change and the Header: Logo, Title, Time Range view.

9 Select the tab showing CPU Utilization (Rolling N Month Summary) and click 
the Test PDF button. 

The new report appears with the image you recently uploaded.

Note Most of the reports share 1 or 2 header views. These headers can all be edited 
directly by expanding vFoglight > Reporting in the upper left-hand content pane of 
the Definitions view.
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Working with Custom Reports
If you have the appropriate permissions, the Report Manager dashboard enables you to 
create a custom report at a more specific level than what is available on the set of 
supplied report templates. By creating your own report templates you can customize the 
content and presentation of a report.

Creating a Custom Report Template
The process of creating a custom report is similar to creating a dashboard. You can add 
any dashboard displayed in the user interface to the list of reports in the Report Manager 
or Report dashboards. Custom reports that you create will appear under My Dashboards 
in the navigation panel. They also appear in the Report Manager dashboard as a report 
template as soon as the report is created, and you can schedule the report. 

To create a custom report:

1 In the navigation panel under Dashboards, click Reports > Report Manager. If 
you do not have access to the Report Manager, in the navigation panel, under 
Dashboards, click Reports > Reports.

2 To create a custom report, click the  Create Report icon on the Reports 
dashboard or Report Manager dashboard or click Create Report... in the action 
panel.

The Create Report dialog box opens.

3 Type a unique name for the report in the Name box. This is the only information 
required to create a new report. 
Tip Since custom reports are listed under My Dashboards in the navigation panel, you 

may want to choose a name that indicates that this is a report.

4 To set access to this report, click the edit icon  beside Relevant Role(s) and 
Allowed Role(s) and select the role(s) to control which users can access the 
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report. For example, choosing "Operator" publishes your dashboard to everyone 
with the Operator role. 

• Relevant Role—this option is only valid for super users who may have 
multiple roles. For example, a Java administrator who also has an operator role 
can choose the Cartridge Developer role to restrict the Operator role from 
accessing the report.

• Allowed Role—determines which user role is allowed to see the dashboard.

5 You can enter a description of the report in the Context Help box. This text 
appears in a tooltip when you hover over the report name in the navigation panel.

6 Click OK to save your report. 

Two additional tabs (Views and Data) appear at the top of the action panel.

7 Select the Views or Data tab and locate the views or portlets that you want to add 
to your report. You can add both types of information to the same report. For 
information on creating and editing charts, see “Creating a Metrics Chart” on 
page 78.

8 To add parameterized inputs to include in your report, click the Data tab. A 
parameterized input allows you to define a view in which you can enter an input 
value for the object during report scheduling or testing the template. 

• Drag an object into the Parameterized Input section. 
• Drag an element from the Parameterized Input section onto the workspace to 

the left. 

9 If you want to add text to the report, click and drag Drag into report to add text 
under Text in the action panel into the display area and type the text in the 
Entering User Text dialog box.

10 If you want to customize the header or footer of the report, click Customize 
header or Customize footer in the action panel. For details, see “Customizing 
the Header or Footer of a Custom Report” on page 215.

11 To divide the display area into one, two, or three columns, choose the number of 
columns in the action panel, under the General tab > Columns. 

12 To see how the report will look when it is printed, click Create PDF in the action 
panel. Use the browser’s Back button to return to the report.

13 You have the option to schedule a report by clicking Schedule Report in the 
Reports dashboard or Reports Manager dashboard. 

When you have finished creating a report, you do not need to save it. It is automatically 
available under My Dashboards in the navigation panel and also appears as a template 
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in the Report Manager, where it can be scheduled. To schedule the report, see 
“Scheduling a Report” on page 194. To run and generate a report without scheduling it, 
see “Running a Report” on page 192.

If you want to preview the report template without scheduling or generating the report, 
see “Adding a New Schedule” on page 198.

Creating a CSV Report
By generating a comma-separated value (CSV) report, you can import raw data for the 
contents of the report into Excel for charting and analysis. 

Note You can also export metrics and generate a CSV report for a table or chart using the 
customizer. See “Exporting Data from Charts and Tables” on page 57.

When scheduling a custom report, you can choose to run a report as either a PDF report 
or a CSV report using the dropdown. See “Scheduling a Report” on page 194.

Note To generate a CSV report, the component type of the report must support CSV output and 
have meaningful results for the CSV report to generate. This applies to most chart and 
tables. For the full list of supported component types, see the Web Component Guide. The 
CSV option will not appear if the report is not capable of generating meaningful CSV data. 
Except for the pre-defined vFMS Database View (diagnostic) report, most default reports 
will not work as CSV reports. 

Customizing the Header or Footer of a Custom Report
You can add custom headers and footers to a custom report while you are creating it, or 
you can customize them at a later time. 

To customize a header or footer:

1 Open the report from the Report Manager dashboard. 

2 Click Customize header or Customize footer in the action panel.

The Customize header (or Customize footer) dialog opens.
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3 Click in a text box to add text, or click Page Number, Report Title, Current 
Time, or Time Range to add those variables to a box. You can add both text and 
variables to a box.

4 If you want to add your own graphic to the report, click the icon to the right of 
Select an Image to open the Select an Image dialog.

5 From the drop-down selector for the left image, navigate to an image that was 
previously uploaded and click OK. For more information on uploading an image, 
see “Adding Your Own Logo to Reports” on page 208.

The image appears in the Customize header dialog box.

6 Use the Size text fields and drop-down menu to adjust the size of the image. 

7 If you leave the Maintain Aspect Ratio check box selected, you need to enter 
only one size value. Clear the check box if you want to change the ratio of the 
image.

8 Click OK to save your changes.

Printing a Custom Report
You can print a custom report in two ways (when it is in the display area):

• Click Print in the action panel and print the HTML page from the Print dialog. 
For more information, see “Printing Views” on page 92.

• Click PDF beside the report to print a gray color PDF output of the report from 
the PDF viewer. To print a colorful PDF report, you need to setup the PDF 
behavior in the User Preferences dashboard under the Themes setting. For more 
information, see “User Preferences” on page 36.

Deleting a Custom Report
You can delete any custom report that you have created. You may also be able to delete 
reports created by other users, depending on the roles that were assigned to them. 
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To delete a report:

1 Select the report that you want to delete from the list under My Dashboards.

2 Click Delete this Report in the Actions panel.

A confirmation dialog box appears.

3 Click Delete to confirm the deletion.

Deleting a report removes the report from the My Dashboards view and the 
Report Template list.

For details about how to work with charts in a dashboard, see “Working with Charts” on 
page 78.

Example: Create a Custom Host Report
In the following example, you will create a simple custom host report in which you will: 

• Include parameterized input in which you can drag and drop views onto your 
report for the Windows_host object. During report scheduling, you can define 
what the report’s input values will be at run-time.

• Include host elements (Virtual Memory metrics).

• Test the template.

• Schedule the report to generate hourly.

To create a custom host report:

1 In the navigation panel under Dashboards, click Reports > Report Manager. If 
you do not have access to the Report Manager, in the navigation panel, under 
Dashboards, click Reports > Reports.

2 Click the  Create Report icon or click Create Report in the action panel.

3 In the dialog box that appears:

a Type a report Name. 

b Select which roles are allowed to view this report. 

- Relevant Role—this option is only valid for SuperUsers who may have 
multiple roles. For example, a Java administrator who also has an operator role 
can choose the Cartridge Developer role to restrict the Operator role from 
accessing the report.
- Allowed Role—select the user role that is allowed to view the report.
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c To make text appear in a tooltip when you hover over the report name in the 
navigation panel, type a description of the report in the Context Help text box.

4 Click OK.

5 Click the Data tab. 

6 Drag a Host object (Windows_Host) into the Parameterized Input section. 
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7 Drag host elements (i.e. VirtualMemory) from the data or input trees of the 
Parameterized Input section onto the display area to the left.

8 On the navigation panel, under Dashboards, click Reports > Report Manager. 
Notice that the report is added to the list of report templates.

9 From the Report Template, choose the report you created.

10 To test (i.e. preview) your report template before generating the report. 

• Click the host report you just created. 
• Click Test. 
• In the Test dialog box, enter the context for the run-time values to include in 

your report. This step is optional.

• Click Test.

11 To generate your report hourly, you need to add a schedule.

• Select the report template you just created from the Report Template column.
• Click  Schedule Report to open the Scheduled Report Editor. 
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12 Enter the report inputs for the time range and Windows host. This step is optional.

13 Click Create to schedule the report.

14 After an hour, the report appears under Generated Reports view.

15 Click pdf to view the generated report.

Example: Create an SLA Availability Report
In the following example workflow, you will create a report showing SLA availability 
data for the workweek from 8 am to 8 pm.

Reporting Parameters
The report will use the following criteria:

• Outages from 8 am to 8 pm

• Time plot with chart type “Stacking area”

• Include number of outages, outage duration and cause(s) of outage

Step 1: Add a New Schedule
To get the 5 time ranges, schedule the report for Friday nights at 7:59 pm. You will need 
to create a new schedule since this is not part of the standard schedules in the Schedule 
drop-down.
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To create a new schedule:

1 In the Report Manager dashboard, click Add New Schedule.

2 Create the schedule. Type a Schedule Name and Description/Comments.

3 Click Next.

4 Add the schedule details.

5 Click Add.

6 View the details of the schedule.
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Step 2: Create the report
To create the report:

1 In the navigation panel under Dashboards, click Reports > Report Manager. If 
you do not have access to the Report Manager, in the navigation panel, under 
Dashboards, click Reports > Reports.

2 Click the  Create Report icon or click Create Report in the action panel.

3 Type a report Name. 

4 If you want to enable this report to be included in other reports, click the Allow 
this report to be included in another report checkbox.

5 Select which roles are allowed to view this report.

• Relevant Role—this option is only valid for super users who may have 
multiple roles. For example, a Java administrator who also has an operator 
role. The Java administrator can choose the Cartridge Developer role to 
restrict the Operator role from accessing the report.

• Allowed Role—select the user role that is allowed to view the report.
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6 You can enter a description of the report in the Context Help text box. This text 
appears in a tooltip when you hover over the report name in the navigation panel.

7 Click OK.

8 Click Set metric chart defaults.

9 In the Chart drop-down choose Stacking Area and click OK. 

10 Create two derived metrics for a specific FSMServiceLevelPolicy:

• Outage - every minute, if previously available and currently not, return 1. The 
sum of this metric over the period gives the number of outages.

• OutageTime - every minute, if unavailable return 60. The sum of this metric 
over the period gives the approximate outage duration.

11 Create Time Chunks query - the last 5 days in 12 hourly chunks.

Step 3: Generate the Report
To generate your report hourly, you need to add a schedule.

1 Select the report template you just created from the Report Template column.

2 Click  Schedule Report to schedule the report.

3 Type a name for the scheduled report.

4 In the Schedule drop-down, select Friday nights at 7:59 pm.

5 Enter the report inputs. 
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6 Click Create to schedule the report.

7 Check that the report appears under Generated Reports with Filter on Friday after 
8:00 pm.

8 Click PDF to view the generated report.

Figure 8
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Working with Data and Data 
Sources

In vFoglight you can create custom views using the framework that is available in the 
Configuration module. This type of work is primarily focused on those users who are 
advanced dashboard designers. 

This chapter contains the following sections:

Overview....................................................................................................................................226
Data Dashboard ........................................................................................................................226
Data Sources Dashboard ..........................................................................................................229
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Overview
The dashboards listed under the Configuration module include the following:

• Data Dashboard

• Data Sources Dashboard

• Definitions

• User Preferences 

The Definitions dashboard is where you create and edit views. For information about 
these functions, see the Web Component Guide and the Web Component Tutorial.

The options in the User Preferences page are described under “User Preferences” on 
page 36.

This section briefly describes the Data and Data Sources dashboards.

Data Dashboard
The Data dashboard is an advanced tool intended for use by dashboard designers and 
data modelers. It shows the underlying set of objects that are available in the system and 
how they are organized. This dashboard is useful for figuring out the paths used to 
define dashboard tooling queries, and for inspecting the underlying objects to ensure 
that the data is collected and transformed properly. 

To display the Data dashboard:

• From the navigation panel, under Dashboards, click Configuration > Data.

The Data dashboard appears.
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Figure 1

You can expand the nodes in the left-hand pane and follow a path to find objects. For 
example, you can find a Host object by expanding the Hosts object, expanding All 
Hosts, then finding the Host of interest (as in the above screen).

The right-hand pane is a display area. You can choose from a number of views, which 
are listed under Views in the action panel. The most useful view for inspecting an object 
is the Property Viewer. The Property Viewer shows the raw object details — the 
property values and metrics.

Understanding Metrics and Observations
In general, vFoglight and the Web Component Framework are concerned with the 
collection of information over time. This collection is referred to as observations. The 
Data dashboard displays metrics and observations for a topology object. 

An observation is a collection of a particular piece of data over time. An 
EnumObservation is the data collected by agents, which is a type of observation where 
the data being observed is a enumerated value. For example, the state of an object.
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A metric is a type of observation that is concerned with numeric observations. For 
example, the CPU usage of a host. 

All observation objects have the following properties:

• latest—the value of the last recorded sample. 

• current—the same as the latest value except if the latest value is considered stale 
(not fresh), the current value is considered null. 

• history—contains a historical list of values for the selected time range.

To view the current, latest, or history values for a topology object:

1 From the navigation panel, under Dashboards, click Configuration > Data.

2 In the Data dashboard, drill-down to the topology object to view the metric 
values:

3 Click on the metric to view more details about the topology objects in the 
Property Viewer. Each value entry for an observation has a Start time, End time, 
and Value.
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Data Sources Dashboard
The Data Sources dashboard is where you choose a data source for vFoglight. The 
default (and only current) option is the foglight-5 data source. Click a data source to 
display its ID, name, and topology and UI query service JNDI names.

To display the Data Sources dashboard:

• From the navigation panel, under Dashboards, click Configuration > Data 
Sources.

The Data Sources dashboard appears.

The icons above the data sources allow you to add , delete , copy , and edit 

 them, as well as set a default  data source.

Caution If you click the Delete icon, the data source is removed without a confirmation dialog.
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